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Trademarks and Copyright 

Trademarks 

Windows is a registered trademark of the Microsoft Corporation in the United States and other countries. 
All other brand and product names are trademarks or registered trademarks of their respective owners. 
Protected trademarks are not marked as such in this manual. This does not mean, however, that they may be used freely. 

Copyright information 

Code provided by third party providers was used for Avira Free Antivirus. We thank the copyright owners for making the code available 
to us. 
For detailed information on copyright, please refer to "Third Party Licenses" in the Program Help of Avira Free Antivirus. 
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1. Introduction 

Your Avira product protects your computer against viruses, worms, Trojans, adware and 
spyware and other risks. In this manual these are referred to as viruses or malware 

(harmful software) and unwanted programs. 

The manual describes the program installation and operation. 

For further options and information, please visit our website: 
http://www.avira.com/free-av 

The Avira website lets you: 

 access information on other Avira desktop programs 

 download the latest Avira desktop programs 

 download the latest product manuals in PDF format 

 download free support and repair tools 

 access our comprehensive knowledge database and FAQs for troubleshooting 

 access country-specific support addresses. 

Your Avira Team 

1.1 Icons and emphases 

The following icons are used: 

Icon / 

designation 

Explanation 

 

Placed before a condition which must be fulfilled prior to 
execution of an action. 

 

Placed before an action step that you perform. 

 

Placed before an event that follows the previous action. 

Warning Placed before a warning when critical data loss might occur. 

http://www.avira.com/free-av
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Note Placed before a link to particularly important information or a tip 
which makes your Avira product easier to use. 

The following emphases are used:   

Emphasis Explanation 

Italics File name or path data. 

Displayed software interface elements (e.g. window section or 
error message). 

Bold Clickable software interface elements (e.g. menu item, 

navigation area, option box or button). 
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2. Product information 

This chapter contains all information relevant to the purchase and use of your Avira 

product: 

 see Chapter: Delivery scope 

 see Chapter: System requirements 

 see Chapter: Licensing and Upgrade 

Avira products are comprehensive and flexible tools you can rely on to protect your 
computer from viruses, malware, unwanted programs and other dangers. 

  Please note the following information: 

Warning 
Loss of valuable data usually has dramatic consequences. Even the best virus 
protection program cannot provide one hundred percent protection from data 
loss. Make regular copies (Backups) of your data for security purposes. 

  

Note 
A program can only provide reliable and effective protection from viruses, 
malware, unwanted programs and other dangers if it is up-to-date. Make sure 
your Avira product is up-to-date with automatic updates. Configure the program 
accordingly. 

2.1 Delivery scope 

Your Avira product has the following functions: 

 Control Center for monitoring, managing and controlling the entire program 

 Central configuration with user-friendly standard and advanced options and context-
sensitive help 

 System Scanner (on-demand scan) with profile-controlled and configurable scan for all 
known types of virus and malware 

 Integration into the Windows Vista User Account Control allows you to carry out tasks 
requiring administrator rights. 

 Real-Time Protection (on-access scan) for continuous monitoring of all file access 
attempts 

 Avira SearchFree Toolbar, a search toolbar integrated in the web browser providing 
quick and convenient search options. It also includes widgets of the most common 
Internet functions.  
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 Web Protection (for Avira Free Antivirus users, only in combination with the Avira 
SearchFree) for monitoring data and files transferred from the Internet using the HTTP 
protocol (monitoring of ports 80, 8080, 3128) 

 Avira Social Network Protection, a monitoring tool, informs parents of their children's 
online activities. It checks their social network accounts for comments, photos etc. that 
may influence the child's reputation in a negative way or may indicate that the child is in 
danger.  

 Avira Free Android Security app is not only focused on anti-theft measures. The app 
helps you to get back your mobile device once you have misplaced it, or even worse: if 
it has been stolen. Furthermore the app allows you to block incoming calls or SMS. 
Avira Free Android Security protects cell phones and smartphones running with the 
Android operating system. 

 Integrated quarantine management to isolate and process suspicious files 

 Rootkits protection for detecting hidden malware installed in your computer system 
(rootkits) 
(Not available under Windows XP 64 bit) 

 Direct access to detailed information on the detected viruses and malware via the 
Internet 

 Simple and quick updates to the program, virus definitions, and search engine through 
Single File Update and incremental VDF updates via a web server on the Internet  

 Integrated Scheduler for planning one-off or recurring jobs such as updates or scans 

 Extremely high virus and malware detection via innovative scanning technology (scan 
engine) including heuristic scanning method 

 Detection of all conventional archive types including detection of nested archives and 
smart extension detection 

 High-performance multithreading function (simultaneous high-speed scanning of 
multiple files) 

2.2 System requirements 

The system requirements are as follows: 

 Computer with Pentium processor or later, at least 1 GHz 

 Operating system 

 Windows XP, newest SP (32 or 64 bit) or 

 Windows Vista, newest SP (32 or 64 bit) or 

 Windows 7, newest SP (32 or 64 bit) 

Note 
Please be advised that our software is currently not compatible with Windows 
8. 
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 At least 150 MB of free hard disk memory space (more if using quarantine for temporary 
storage) 

 At least 512 MB RAM under Windows XP 

 At least 1024 MB RAM under Windows Vista, Windows 7 

 For the program installation: Administrator rights 

 For all installations: Windows Internet Explorer 6.0 or higher 

 Internet connection where appropriate (see Installation) 

Avira SearchFree Toolbar 

 Operating system 

 Windows XP, newest SP (32 or 64 bit) or 

 Windows Vista, newest SP (32 or 64 bit) or 

 Windows 7, newest SP (32 or 64 bit) 

 Web browser 

 Windows Internet Explorer 6.0 or higher 

 Mozilla Firefox 3.0 or higher 

 Google Chrome 18.0 or higher 

Note 
If necessary, please uninstall any previously installed search toolbars before 
you install the Avira SearchFree Toolbar. Otherwise you will not be able to 

install the Avira SearchFree Toolbar. 

Information for Windows Vista users 

On Windows XP, many users work with administrator rights. However, this is not desirable 
from the point of view of security because it is then easy for viruses and unwanted 
programs to infiltrate computers. 

For this reason, Microsoft is introducing the "User Account Control" with Windows Vista. 
This offers more protection for users who are logged in as administrators: thus in Windows 
Vista, an administrator only has the privileges of a normal user at first. Actions for which 
administrator rights are required are clearly marked in Windows Vista with an information 
icon. In addition, the user must explicitly confirm the required action. Privileges will only 
then be increased and the administrative task will be performed by the operating system 

after this permission has been obtained. 

The Avira product requires administrator rights for some actions in Windows Vista. These 

actions are marked with the following symbol: . If this symbol also appears on a button, 
administrator rights are required to carry out this action. If your current user account does 
not have administrator rights, the Windows Vista dialog of the User Account Control asks 
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you to enter the administrator password. If you do not have an administrator password, 
you cannot carry out this action. 

2.3 Licensing and Upgrade 

In order to be able to use your Avira product, you require a license. You thereby accept the 

license terms. 

The license is issued via a digital license code in the form of a .KEY file. This digital 
license code is the key to your personal license. It contains exact details of which 
programs are licensed to you and for what period of time. A digital license code can 
therefore also contain the license for more than one product. 

If you purchased your Avira product on the Internet, or via a program CD/DVD, the digital 
license code is sent to you by email.  
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3. Installation and uninstallation 

This chapter contains information relating to the installation and uninstallation of your Avira 

product. 

 see Chapter: Pre-Setup: Requirements, preparing the computer for installation 

 see Chapter: Express installation: Standard installation according to default settings 

 see Chapter: Custom installation: Configurable installation 

 see Chapter: Configuration Wizard 

 see Chapter: Change installation 

 see Chapter: Installation modules 

 see Chapter: Uninstallation: Uninstall 

3.1 Installation types 

During installation you can select a setup type in the installation wizard: 

Express 

 The program files are installed into a default folder in C:\Program Files. 

 Your Avira product will be installed with default settings. You have the option of defining 
custom settings using the configuration wizard. 

Custom 

 You can choose to install individual program components (see Chapter Installation and 
uninstallation > Installation modules). 

 A target folder can be selected for the program files to be installed. 

 You can disable Create a desktop icon and program group in the Start menu. 

 Using the configuration wizard, you can define custom settings for your Avira product 
and initiate a short system scan that is performed automatically after installation. 

3.2 Pre-Setup 

Note 
Before installation, check whether your computer fulfills all the minimum system 
requirements. If your computer satisfies all requirements, you can install the 

Avira product. 
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Note 
When installing on a server operating system, the Real-Time Protection and the 

files protection are not available. 

Pre-Setup 

  Close your email program. It is also recommended to end all running applications. 
  Make sure that no other virus protection solutions are installed. The automatic 

protection functions of various security solutions may interfere with each other. 

  The Avira product will search for any possible incompatible software on your 
computer. 

  If potentially incompatible software is detected Avira generates a list of these 
programs. 

  It is recommended to remove these software programs in order not to endanger 
the stability of your computer. 

  Select from the list the check boxes of all those programs that should be removed 
automatically from your computer and click Next. 

  You have to confirm manually the uninstallation of some programs. Select the 
programs and click Next. 

  The uninstallation of one or more of the selected programs requires a restart of 
your computer. After rebooting the installation will continue. 

Warning 
Your computer will not be protected until the installation of the Avira product is 

finished. 

Installation 

The installation program runs in self-explanatory dialog mode. Every window contains a 

certain selection of buttons to control the installation process. 

The most important buttons are assigned the following functions:  

 OK: Confirm action. 

 Abort: Abort action. 

 Next: Go to next step. 

 Back: Go to previous step. 

  Establish an Internet connection: The Internet connection is necessary for performing 
the following installation steps: 

 Downloading the current program file and scan engine as well as the latest virus 
definition files via the installation program (for Internet-based installation) 
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 Where appropriate, carrying out an update after completed installation 

  Keep the activation code or license file for your Avira product handy when you want 
to activate the program. 

Note 
Internet-based installation: 
For the Internet-based installation of the program, an installation program is 
provided that loads the current program file prior to installation by the Avira 
web servers. This process ensures that your Avira product is installed with 
the latest virus definition file. 
 
Installation with an installation package: 
The installation package contains both the installation program and all 

necessary program files. No language selection for your Avira product is 
available for installation with an installation package. We recommend that 
you carry out an update of the virus definition file after installation. 

  

3.3 Express installation 

Installing your Avira product: 

Start the installation program by double-clicking the installation file you have downloaded 
from the Internet or insert the program CD. 

Internet-based installation 

  The Welcome screen appears. 

  Click Next to continue with the installation. 

  The dialog Language selection appears. 

  Select the language you want to use to install your Avira product and confirm your 
language selection by clicking Next. 

  The dialog box Download appears. All files necessary for installation are 
downloaded from the Avira web servers. The Download window closes after 
conclusion of the download. 

Installation with an installation package 

  The window Preparing installation appears. 

  The installation file is extracted. The installation routine is started. 

  The dialog box Choose installation type appears. 
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Note 
By default Express installation is preset. All standard components will be 
installed which you may not configure. If you would like to execute a customized 
installation, please refer to the chapter: Installation and uninstallation > Custom 

installation. 

  Confirm that you accept the End User License Agreement. For reading the detailed 
text of the End User License Agreement, click the EULA link. 

  Click Next. 

  The dialog box Join the millions of Avira users who already use Avira 
SearchFree appears. 

  If you do not  want to install the Avira SearchFree Toolbar, please unmark the 
checkbox with the Avira SearchFree Toolbar and Avira SearchFree Updater End 
User License Agreement, and the one that defines Avira SearchFree 
(search.avira.com) as your browser homepage. 

Note 
If necessary, please uninstall any previously installed search toolbars before 
you install the Avira SearchFree Toolbar. Otherwise you will not be able to 

install the Avira SearchFree Toolbar. 

  Click Next. 

  The installation progress is displayed by a green bar. 

  Click Finish to end setup process and close the License Wizard. 

  The Avira Tray Icon is placed in the taskbar. 

  In order to ensure effective protection for your computer, the module Updater will 
search for possible updates. 

  The Luke Filewalker window opens and a short system scan is performed. The 
status of the scan as well as the results are displayed. 

  If after the scan you are asked to restart your computer, click Yes to ensure that your 
system is fully protected. 

After a successful installation, we recommend that you check the program is up-to-date in 
the Status field of the Control Center. 

  If your Avira product shows that your computer is not secure, click Fix problem. 

  The dialog Restore protection opens. 

  Activate the preset options in order to maximize the security of your system. 

  If appropriate, perform a complete system scan afterwards. 
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3.4 Custom installation 

Installing your Avira product: 

Start the installation program by double-clicking the installation file you have downloaded 
from the Internet or insert the program CD. 

Internet-based installation 

  The Welcome screen appears. 

  Click Next to continue with the installation. 

  The dialog Language selection appears. 

  Select the language you want to use to install your Avira product and confirm your 
language selection by clicking Next. 

  The dialog box Download appears. All files necessary for installation are 
downloaded from the Avira web servers. The Download window closes after 
conclusion of the download. 

Installation with an installation package 

  The window Preparing installation appears. 

  The installation file is extracted. The installation routine is started. 

  The dialog box Choose installation type appears. 

Note 
By default Express installation is preset. All standard components will be 
installed which you may not configure. If you would like to execute an Express 
installation, please refer to the chapter: Installation and uninstallation > Express 

installation. 

  Choose Custom to install individual program components. 

  Confirm that you accept the End User License Agreement. For reading the detailed 
text of the End User License Agreement, click the EULA link. 

  Click Next. 

  The dialog box Join the millions of Avira users who already use Avira 
SearchFree appears. 

  If you do not want to install the Avira SearchFree Toolbar, please unmark the 
checkbox with the Avira SearchFree Toolbar and the Avira SearchFree Updater End 
User License Agreement, and the one that defines Avira SearchFree 
(search.avira.com) as your browser homepage. 
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Note 
If necessary, please uninstall any previously installed search toolbars before 
you install the Avira SearchFree Toolbar. Otherwise you will not be able to 
install the Avira SearchFree Toolbar. 

  Click Next. 

  The Choose Destination Folder window opens. 

  The default folder will be C:\Program Files\Avira\AntiVir Desktop\ 

  Click Next to continue. 

 -OR- 

 Use the Browse button to select a different destination folder and confirm by clicking 
Next. 

  The Install components dialog appears. 

  Select or deselect components from the list and confirm with Next to proceed. 

  In the following dialog box you can decide whether to create a desktop shortcut 
and/or a program group in the Start menu. 

  Click Next. 

  Click Finish to end setup process. 

  The Installation Wizard is closed and the Configuration Wizard will open. 

3.5 Configuration Wizard 

At the end of a user-defined installation, the configuration wizard is opened. The 
configuration wizard enables you to define custom settings for your Avira product. 

  Click Next in the welcome window of the configuration wizard to begin configuration 
of the program. 

  The Configure AHeAD dialog box enables you to select a detection level for the 
AHeAD technology. The detection level selected is used for the System Scanner 
(On-demand scan) and Real-Time Protection (On-access scan) AHeAD 
technology settings. 

  Select a detection level and continue the installation by clicking Next. 

  In the following dialog box Select extended threat categories, you can adapt 
the protective functions of your Avira product to the threat categories specified. 

  Where appropriate, activate further threat categories and continue the installation by 
clicking Next. 

  If you have selected the Avira Real-Time Protection installation module, the 
Real-Time Protection start mode dialog box appears. You can stipulate the 
Real-Time Protection start time. At each computer reboot, the Real-Time 
Protection will be started in the start mode specified. 
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Note 
The specified Real-Time Protection start mode is saved in the registry and 

cannot be changed via Configuration. 

  

Note 
If the default start mode for Real-Time Protection (Normal start) has been 
chosen and the logon process upon startup is carried out fast, programs 
configured to start automatically upon startup might not be scanned, because 
they might be up and running before the Real-Time Protection has been started 
completely. 

  Enable the required option and continue the configuration by clicking Next. 

  In the following System scan dialog box, a quick system scan can be enabled or 
disabled. The quick system scan is performed after the configuration has been 
completed and before the computer is rebooted, and scans running programs 
and the most important system files for viruses and malware. 

  Enable or disable the Quick system scan option and continue the configuration by 
clicking Next. 

  In the following dialog box, you can complete the configuration by clicking Finish 

  The specified and selected settings are accepted. 

  If you have enabled the Quick system scan option, the Luke Filewalker 
window opens. The Scanner performs a quick system scan. 

  If you are asked to restart your computer after the scan, click Yes to ensure that your 
system is fully protected. 

After a successful installation, we recommend that you check whether the program is up-
to-date in the Status field of the Control Center. 

  If your Avira product shows that your computer is not secure, click Fix problem. 

  The dialog Restore protection opens. 

  Activate the preset options in order to maximize the security of your system. 

  If appropriate, perform a complete system scan afterwards. 

3.6 Change installation 

You have the option of adding or removing individual program components of the current 
Avira product installation (see Chapter Installation and uninstallation > Installation 

modules). 
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If you wish to add or remove modules of the current installation, you can use the option 
Add or Remove Programs in the Windows control panel to Change/Remove 

programs. 

Select your Avira product and click Change. In the Welcome dialog of the program, select 
the option Modify. You will be guided through the installation changes. 

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 
uninstalled. 

3.7 Installation modules 

In a user-defined installation or a change installation, the following installation modules can 
be selected, added or removed. 

 Avira Free Antivirus 
This module contains all components required for successful installation of your Avira 
product. 

 Real-Time Protection 
The Avira Real-Time Protection runs in the background. It monitors and repairs, if 
possible, files during operations such as open, write and copy in on-access mode. 
Whenever a user carries out a file operation (e.g. load document, execute, copy), the 
Avira product automatically scans the file. Renaming a file does not trigger a scan by 
Avira Real-Time Protection. 

 Rootkits Protection 

Avira Rootkits Protection checks whether software is already installed on your computer 
that can no longer be detected with conventional methods of malware protection after 
penetrating the computer system. 

 Web Protection (for Avira Free Antivirus users, only in combination with the Avira 
SearchFree Toolbar) 
When surfing the Internet, you are using your web browser to request data from a web 
server. The data transferred from the web server (HTML files, script and image files, 
Flash files, video and music streams, etc.) will normally be moved directly into the 
browser cache for display in the web browser, meaning that an on-access scan as 
performed by Avira Real-Time Protection is not possible. This could allow viruses and 
unwanted programs to access your computer system. Web Protection is what is known 
as an HTTP proxy which monitors the ports used for data transfer (80, 8080, 3128) and 
scans the transferred data for viruses and unwanted programs. Depending on the 
configuration, the program may process the affected files automatically or prompt the 
user for a specific action. 

 Shell Extension 
The Shell Extension generates an entry Scan selected files with Avira in the context 
menu of the Windows Explorer (right-hand mouse button). With this entry you can 
directly scan files or directories. 
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3.8 Uninstallation 

If you wish to remove the Avira product from your computer, you can use the option Add 
or Remove Programs to Change/Remove programs in the Windows Control Panel. 

To uninstall your Avira product (e.g. in Windows 7): 

  Open the Control Panel via the Windows Start menu. 

  Double click on Programs and Features. 

  Select your Avira product in the list and click Uninstall. 

  You will be asked if you really want to remove the program. 

  Click Yes to confirm. 

  All components of the program will be removed. 

  Click Finish to complete uninstallation. 

  Where appropriate, a dialog box appears recommending that your computer be 
restarted. 

  Click Yes to confirm. 

  The Avira product is now uninstalled and all directories, files and registry entries 
for the program are deleted when your computer is restarted. 

Note 
The Avira SearchFree Toolbar is not included in the uninstallation program and 
must be uninstalled separately by following the steps detailed above. To do this 
in Firefox the Avira SearchFree Toolbar must be enabled via the Add-On 
Manager. After uninstallation the search toolbar is no longer integrated in your 
web browser. 

  

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 

uninstalled. 
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4. Overview of Avira Free Antivirus 

This chapter contains an overview of the functionality and operation of your Avira product. 

 see Chapter Interface and operation 

 see Chapter Avira SearchFree Toolbar 

 see Chapter How to...? 

4.1 User interface and operation 

You operate your Avira product via three program interface elements: 

 Control Center: monitoring and controlling the Avira product 

 Configuration: Configuring the Avira product 

 Tray Icon in the system tray of the taskbar: Opening the Control Center and other 
functions 

4.1.1 Control Center 

The Control Center is designed to monitor the protection status of your computer systems 

and control and operate the protection components and functions of your Avira product. 
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The Control Center window is divided into three areas: The Menu bar, the Navigation bar 
and the detail window Status: 

 Menu bar: In the Control Center menu bar, you can access general program functions 
and information on the program. 

 Navigation area: In the navigation area, you can easily swap between the individual 
sections of the Control Center. The individual sections contain information and functions 
of the program components and are arranged in the navigation bar according to activity. 
Example: Activity PC PROTECTION - Section Real-Time Protection. 

 Status: The Control Center opens with the Status view, where you can see at a glance, 
if your computer is safe, and you have an overview of the active modules, the date of 
the last backup and the date of the last system scan. The Status view also contains 
buttons for starting features or actions, such as starting or stopping the Real-Time 

Protection. 

Starting and closing of Control Center 

To start the Control Center the following options are available: 

 Double-click the program icon on your desktop 

 Via the program entry in the Start > Programs menu. 
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 Via the Tray Icon of your Avira product. 

Close the Control Center via the menu command Close in the menu File or by clicking on 

the close tab in the Control Center. 

Operate Control Center 

To navigate in the Control Center 

  Select an activity in the navigation bar. 

  The activity opens and other sections appear. The first section of the activity is 
selected and displayed in the view. 

  If necessary, click another section to display this in the detail window. 

Note 
You can activate the keyboard navigation in the menu bar with the help of the 
[Alt] key. If navigation is activated, you can move within the menu with the 
arrow keys. With the Return key you activate the active menu item. 
To open or close menus in the Control Center, or to navigate within the menus, 
you can also use the following key combinations: [Alt] + underlined letter in the 
menu or menu command. Hold down the [Alt] key  if you want to access a 
menu, a menu command or a submenu. 

To process data or objects displayed in the detail window: 

  Highlight the data or object you wish to edit. 

 To highlight multiple elements (elements in columns), hold down the control key or 
the shift key while selecting the elements. 

  Click the appropriate button in the upper bar of the detail window to edit the object. 

Control Center overview 

 Status: Clicking on the Status bar gives you an overview of the product's functionality 
and performance (see Status). 

 The Status section lets you see at a glance which modules are active and provides 
information on the last update performed.  

 PC PROTECTION: In this section you will find the components for checking the files on 

your computer system for viruses and malware. 

 The System Scanner section enables you to easily configure and start an on-demand 
scan. Predefined profiles enable a scan with already adapted default options. In the 
same way it is possible to adapt the scan for viruses and unwanted programs to your 
personal requirements with the help of manual selection (will be saved). 

 The Real-Time Protection section displays information on scanned files, as well as 
other statistical data, which can be reset at any time, and enables access to the 
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report file. More detailed information on the last virus or unwanted program detected 
can be obtained practically "at the push of a button". 

 INTERNET PROTECTION: In this section you will find the components to protect your 
computer system against viruses and malware from the Internet, and against 
unauthorized network access. 

 The Web Protection section displays information on scanned URLs and detected 
viruses, as well as other statistical data, which can be reset at any time and enables 
access to the report file. More detailed information on the last virus or unwanted 
program detected can be obtained practically "at the push of a button". 

 CHILD PROTECTION:  In this section you will find the components to ensure a safe 
Internet experience for your children. 

 SocialShield: From this section you will be redirected to the SocialShield access. 

SocialShield informs parents of their children's activities online. It checks their social 
network accounts for comments, photos etc. that may influence the child's reputation 
in a negative way or may indicate that the child is in danger. 

 MOBILE PROTECTION: From this section you will be redirected to the online access 
for Android devices. 

 Avira Free Android Security manages all your android-based devices. 

 ADMINISTRATION: In this section you will find tools for isolating and managing 
suspicious or infected files, and for planning recurring tasks. 

 The Quarantine section contains the so-called quarantine manager. This is the 
central point for files already placed in quarantine or for suspect files that you would 
like to place in quarantine. It is also possible to send a selected file to the Avira 
Malware Research Center by email. 

 The Scheduler section enables you to configure scheduled scanning and update jobs 
as well as backup jobs and to adapt or delete existing jobs. 

 The Reports section enables you to view the results of actions performed. 

 The Events section enables you to view events generated by certain program 
modules. 

4.1.2 Configuration 

You can define settings for your Avira product in the Configuration. After installation, your 
Avira product is configured with standard settings, ensuring optimal protection for your 
computer system. However, your computer system or your specific requirements for your 

Avira product may mean you need to adapt the protective components of the program. 
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The Configuration opens a dialog box: You can save your configuration settings via the 
OK or Apply buttons, delete your settings by clicking the Cancel button or restore your 
default configuration settings using the Default values button. You can select individual 

configuration sections in the left-hand navigation bar. 

Accessing the Configuration 

You have several options for accessing the configuration: 

 via the Windows control panel. 

 via the Windows Security Center - from Windows XP Service Pack 2. 

 via the Tray Icon of your Avira product. 

 in the Control Center via the menu item Extras > Configuration. 

 in the Control Center via the Configuration button. 

Note 
If you are accessing configuration via the Configuration button in the Control 
Center, go to the Configuration register of the section which is active in the 
Control Center. Expert mode must be activated to select individual 
configuration registers. In this case, a dialog appears asking you to activate 

expert mode. 
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Configuration operation 

Navigate in the configuration window as you would in Windows Explorer: 

  Click an entry in the tree structure to display this configuration section in the detail 
window. 

  Click the plus symbol in front of an entry to expand the configuration section and 
display configuration subsections in the tree structure. 

  To hide configuration subsections, click on   the minus symbol in front of the 
expanded configuration section. 

Note 
To enable or disable Configuration options and use the buttons, you can also 

use the following key combinations: [Alt] + underlined letter in the option name 
or button description. 

  

Note 
All configuration sections are only displayed in expert mode. Activate expert 
mode to view all configuration sections. Expert mode can be protected by a 

password that must be defined during activation. 

If you want to confirm your Configuration settings: 

  Click OK. 

  The configuration window is closed and the settings are accepted. 

 - OR - 

  Click Accept. 

  The settings are applied. The configuration window remains open. 

If you want to finish configuration without confirming your settings: 

  Click Cancel. 

  The configuration window is closed and the settings are discarded. 

If you want to restore all configuration settings to default values: 

  Click Restore defaults. 

  All settings of the configuration are restored to default values. All amendments 
and custom entries are lost when default settings are restored. 

Overview of configuration options 

The following configuration options are available: 
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 System Scanner: Configuration of on-demand scan 

 Action on detection  

 Archive scan options 

 System scan exceptions 

 System scan heuristics 

 Report function setting 

 Real-Time Protection: Configuration of on-access scan 

 Scan options 

 Action on detection  

 Further actions 

 On-access scan exceptions 

 On-access scan heuristics 

 Report function setting 

 Update: Configuration of the update settings, set-up of product updates 

 Set-up of product updates 

 Restart settings 

 Proxy settings 

 Web Protection: Configuration of Web Protection 

 Scan options, enabling and disabling the Web Protection 

 Action on detection 

 Blocked access: Unwanted file types and MIME types 

 Web Protection scan exceptions: URLs, file types, MIME types 

 Web Protection heuristics 

 Report function setting 

 General: 

 Threat categories for System Scanner and Real-Time Protection 

 Application filter: Block or allow applications 

 Password protection for access to the Control Center and the Configuration 

 Security: block autostart function, complete system scan status display, product 
protection, protect Windows hosts file  

 WMI: Enable WMI support 

 Event log configuration 

 Configuration of report functions 

 Setting of directories used 

4.1.3 Tray icon 

After installation, you will see the tray icon of your Avira product in the system tray of the 

taskbar: 
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Icon Description 

 

Avira Real-Time Protection is 

enabled 

 

Avira Real-Time Protection is 

disabled 

The tray icon displays the status of the Real-Time Protection service. 

Central functions of your Avira product can be quickly accessed via the context menu of 
the tray icon. To open the context menu, click the tray icon with the right-hand mouse 

button. 

Entries in the context menu 

 Enable Real-Time Protection: Enables or disables the Avira Real-Time Protection. 

 Enable Web Protection: Enables or disables the Avira Web Protection. 

 Start Avira Free Antivirus: Opens the Control Center. 

 Configure Avira Free Antivirus: Opens the Configuration. 

 My messages: Opens a slide-up with the current information about your Avira product. 

 Start update Starts an update. 

 Help: opens the Online Help. 

 Experts Market - Ask for help: opens the Experts Market - Ask for help website where 
you can ask for help or offer your help to other users.  

 About Avira Free Antivirus: Opens a dialog box with information on your Avira 
product: Product information, Version information, License information. 

 Avira on the Internet: Opens the Avira web portal on the Internet. The condition for this 
is that you have an active connection to the Internet. 

4.2 Avira SeachFree Toolbar 

Avira SearchFree Toolbar includes two main components: Avira SearchFree and the 

Toolbar. 

The Avira SearchFree Toolbar is installed as an add-on. When the browser is first 
accessed (in Firefox and Internet Explorer) a message will pop-up, asking you for 
permission to install the toolbar. You will have to accept in order to complete a successful 

installation of Avira SearchFree Toolbar. 
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Avira SearchFree is a search engine and contains a clickable Avira logo linked to the Avira 
website and web, image and video channels. This allows Avira users a safer Internet 

navigation. 

The toolbar, integrated in your web browser, consists of a search box, an Avira logo linked 
to the Avira website, two status displays, three widgets and the Options menu. 

 Search toolbar 
Use the search toolbar for free to quickly search the Internet using the Avira search 
engine. 

 Status display 
The status displays provide information on the status of the Web Protection and the 
current update status of your Avira product and helps you identify which actions you 
need to take to protect your PC. 

 Widgets 
Avira offers you three widgets to the most important Internet-related functions. With one 
click you have direct access to Facebook and your email, or you can ensure safe web 
browsing (Firefox and Internet Explorer only). 

 Options 
You can use the Options menu to access the toolbar options, clear the history, find 
toolbar help and information and also uninstall the Avira SearchFree Toolbar directly via 
the web browser (Firefox and Internet Explorer only). 

4.2.1 Use 

Avira SearchFree 

You can use Avira SearchFree to define any number of terms to browse the Internet. 

Enter the term in the search box and press the Enter key or click on Search. The Avira 
SearchFree engine then searches the Internet for you and displays all hits in the browser 
window. 

To find out how to custom configure Avira SearchFree in Internet Explorer, Firefox and 
Chrome, go to Options. 

Status display 

Web Protection  
You can use the following icons and messages to identify which actions you need to take 

to protect your PC:  

    Web Protection 

If you move the cursor over the icon, the following message appears: Avira Web 

Protection is active. Your browsing is protected. 
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  No further action is necessary. 

    Web Protection is inactive 

If you move the cursor over the icon, the following message appears: Avira Web 
Protection is off.  Click to find out how to turn it on. 

  You will be redirected to one of our Knowledge Base articles. 

    No Web Protection 

If you move the cursor over the icon, one of the following messages appears:  

 You do not have Avira Web Protection installed. Click to find out how to protect your browsing.  

 This message will appear if you install incorrectly or uninstall the Avira Antivirus. 

 Web Protection is included for free with Avira Antivirus. Click to find out how to install it.  

 This message will appear if you do not install Web Protection or if you uninstall it. 

  In both cases, you will be redirected to the Avira homepage, where you can 
download the Avira product . 

   Error 

If you move the cursor over the icon, the following message appears: Avira reported an 

error. Click to contact Support for help. 

  Click the gray icon or text to go to the Avira Support page. 

Widgets 

Avira SearchFree contains three widgets with the most important functions for the 
nowadays Internet web browsing:  Facebook, E-mail and  Browser Security. 

Facebook 
 
This function allows you to receive all the messages from Facebook and to be always 

updated. 

Email 
 
If you click the email symbol in the toolbar, a dropdown list  will be shown. You can choose 

between the most commonly used email providers. 

Browser Security 
 
This widget has been conceived to offer you in one click all the Internet security options 
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you may need on daily basis. This option is only available for Firefox and Internet Explorer. 
Also the names of the functions sometimes change from one browser to another:  

 Pop-up Blocker 

If this option is activated, all pop-up windows will be blocked. 

 Block Cookies 

If you activate this option, no cookies will be saved on your computer. 

 Private Browsing (Firefox) / InPrivate Browsing (Internet Explorer) 

 Enable this option if you do not want to leave any personal information on the Internet 
while you surf. This option is not available for Internet Explorer 7 and 8. 

 Clear Recent History (Firefox) / Delete Browsing History (Internet Explorer) 

With this option you will erase all traces of your Internet activities. 

Website Safety Advisor 
 
The Website Safety Advisor offers you a safety ranking while navigating.  
You can assess the reputation of the website you are visiting, and check if it poses a low 
or a high risk to your security. 
This widget also provides further information on the website, like who is the domain owner, 

or why the website has been categorized as safe or risky.  

The status of the Website Safety Advisor is displayed in the Toolbar and in your search 
results, as an Avira tray icon in combination with other icons: 

    Safe 

A green check mark for safe websites.  

    Low risk 

A yellow exclamation mark for websites representing a low risk.  

    High risk 

A red stop sign for websites representing a high risk to your security.  

    Unknown 

A grey question mark will appear when the status is unknown.  

    Verifying 

This sign will appear while verifying the status of a website. 
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Browser Tracking Blocker 
 
With the Browser Tracking Blocker you can stop trackers from collecting information about 
you while you are surfing.  
The widget allows you to choose which trackers to block and which ones to allow.  

The tracking companies are classified in three categories:  

 Social Networks 

 Ad Networks 

 Other companies 

4.2.2 Options 

Avira SearchFree Toolbar is compatible with Internet Explorer, Firefox  and Google 
Chrome and can be configured in the three web browsers: 

 Internet Explorer configuration options 

 Firefox configuration options 

 Google Chrome configuration options 

Internet Explorer 

In Internet Explorer, the following configuration options for the Avira SearchFree Toolbar 
are available in the Options menu: 

Toolbar options 

Search 

Avira search engine 

In the Avira search engine menu, you can select which search engine to use for the 
search. Search engines are available for the USA, Brazil, Germany, Spain, Europe, 

France, Italy, the Netherlands, Russia and the United Kingdom. 

Open searches in 

In the Open searches in option menu, you can select where the search result should 
be displayed; in the Current window, in a New window or on a New tab. 

Display recent searches 

If the Display recent searches option is enabled, you can display previous search 
terms under the text entry box of the search toolbar. 

Auto clear recent search history when I close the browser 

Enable the option Auto clear recent search history when I close the browser if you 
do not want to save previous searches and want to clear the history when you close 

the web browser. 



 Overview of Avira Free Antivirus 

Avira Free Antivirus - User Manual (Status: 24 Sep. 2012) 34 

More options 

Select toolbar language 

Under Select toolbar language you can select the language in which Avira 
SearchFree Toolbar is displayed. The toolbar is available in English, German, 
Spanish, French, Italian, Portuguese and Dutch. 

Note 
Where possible, the default Avira SearchFree Toolbar language corresponds to 
that of your program. If the toolbar is not available in your language, the default 
language is English. 

Show button text labels 

Disable the Show button text labels option if you want to hide the text next to the 
Avira SearchFree Toolbar icons. 

Clear history 

Enable the Clear history option if you do not want to save previous searches and 
want to clear the history immediately. 

Help 

Click on Help to access the website containing frequently asked questions (FAQs) 
relating to the toolbar. 

Uninstall 

You can also uninstall Avira SearchFree Toolbar directly in Internet Explorer: 
Uninstallation via the web browser 

About 

Click on About to display which version of Avira SearchFree Toolbar is installed. 

Firefox 

In the Firefox web browser, the following configuration options for the Avira SearchFree 

Toolbar are available in the Options menu: 
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Toolbar options 

Search 

Select Avira search engine 

In the Avira search engine menu, you can select which search engine to use for the 
search. Search engines are available for the USA, Brazil, Germany, Spain, Europe, 

France, Italy, the Netherlands, Russia and the United Kingdom. 

Display recent searches 

If the Display recent searches option enabled, you can display previous search terms 
by clicking on the arrow in the search toolbar. Select a term if you want to display the 
search result again. 

Auto clear recent search history when I close the browser 

Enable the option Auto clear recent search history when I close the browser if you 
do not want to save previous searches and want to clear the history when you close 

the web browser. 

Display Avira search results when I type keywords or invalid URLs into the 
browser address bar 

If this option is enabled, a search is initiated and the search result displayed every time 
you enter keywords or an invalid URL into the web browser's address bar. 

More options 

Select toolbar language 

Under Select toolbar language you can select the language in which Avira 
SearchFree Toolbar is displayed. The toolbar is available in English, German, 

Spanish, French, Italian, Portuguese and Dutch. 

Note 
Where possible, the default Avira SearchFree Toolbar language corresponds to 
that of your program. If the toolbar is not available in your language, the default 

language is English. 

Show button text labels 

Disable the Show button text labels option if you want to hide the text next to the 
Avira SearchFree Toolbar icons. 

Clear history 

Enable the Clear history option if you do not want to save previous searches and 
want to clear the history immediately. 
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Help 

Click on Help to access the website containing frequently asked questions (FAQs) 
relating to the toolbar. 

Uninstall 

You can also uninstall Avira SearchFree Toolbar directly in Firefox: Uninstallation via 
the web browser. 

About 

Click on About to display which version of Avira SearchFree Toolbar is installed. 

Google Chrome 

In the Chrome web browser, the following configuration options for Avira SearchFree 

Toolbar are available under the menu of the red Avira umbrella: 

Help 

Click on Help to access the website containing frequently asked questions (FAQs) 
relating to the toolbar. 

Uninstall instructions 

Here you will be linked to the articles that contain all the information you need to 
uninstall the toolbar. 

About 

Click on About to display which version of the Avira SearchFree Toolbar is installed. 

Show/ Hide the Avira SearchFree Toolbar 

Click here to hide or show Avira SearchFree Toolbar on your web browser. 

4.2.3 Uninstallation 

To uninstall your Avira SearchFree Toolbar (e.g. in Windows 7): 

  Open the Control Panel via the Windows Start menu. 

  Double click on Programs and Features. 

  Select the Avira SearchFree Toolbar plus Web Protection in the list and click 
Uninstall. 

  You will be asked if you really want to uninstall this product. 
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  Click Yes to confirm. 

  Avira SearchFree Toolbar plus Web Protection is uninstalled and all directories, 
files and registry entries for the Avira SearchFree Toolbar plus Web Protection 
are deleted when your computer is restarted. 

Uninstallation via the web browser 

You also have the option of uninstalling the Avira SearchFree Toolbar directly in the 

browser. This option is only available for Firefox and Internet Explorer: 

  In the search toolbar open the Options menu. 

  Click Uninstall. 

  If you have opened your web browser, you will now be asked to close it. 

  Close the web browser and click OK. 

  Avira SearchFree Toolbar plus Web Protection is uninstalled and all directories, 
files and registry entries for the Avira SearchFree Toolbar plus Web Protection 
are deleted when your computer is restarted. 

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 

uninstalled. 

Note 
Note that to uninstall the Avira SearchFree Toolbar, the toolbar must be 

enabled in the Add-On Manager. 

Uninstallation as add-on 

Because the toolbar is installed as an add-on, it can obviously also be uninstall as one: 

Firefox 

 Click Tools > Add-ons > Extensions. From there you can manage the Avira Add-on: 
activate or deactivate the toolbar and uninstall. 

Internet Explorer 

 Go to Manage Add-ons > Toolbars und Extensions. Here you can either activate and 
deactivate your Avira SearchFree Toolbar, or uninstall it. 

Google Chrome 

 Click  Options > Extensions and manage easily your toolbar: activate, deactivate or 
uninstall it. 
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4.3 How to...? 

The chapters "How to...?" offer short instructions about license and product activation as 
well as information on the most important functions of your Avira product. The selected 
short articles serve as an overview about the functionality of your Avira product. They do 

not substitute the detailed information of each section of this help center. 

4.3.1 Perform automatic updates 

To create a job with the Avira Scheduler to update your Avira product automatically: 

  In the Control Center, select the section ADMINISTRATION > Scheduler. 

  Click the   Insert new job icon. 

  The dialog box Name and description of the job appears. 

  Give the job a name and, where appropriate, a description. 

  Click Next. 

  The dialog box Type of job is displayed. 

  Select Update job from the list. 

  Click Next. 

  The dialog box Time of job appears. 

  Select a time for the update: 

 Immediately 

 Daily 

 Weekly 

 Interval 

 Single 

Note 
We recommend regular and frequent updates. The recommended update 

interval is: 6 hours. 

  Where appropriate, specify a date according to the selection. 

  Where appropriate, select additional options (availability depends on type of job): 

 Repeat job if time has expired 

 Past jobs are performed that could not be performed at the required time, for 
example because the computer was switched off. 

  Click Next. 
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  The dialog box Select display mode appears. 

  Select the display mode of the job window: 

 Invisible: No job window 

 Minimize: progress bar only 

 Maximize: Entire job window 

  Click Finish. 

  Your newly created job appears on the start page of the ADMINISTRATION > 
Scheduler section with the status enabled (check mark). 

  Where appropriate, deactivate jobs that are not to be performed. 

Use the following icons to further define your jobs: 

    View properties of a job 

    Edit job 

    Delete job 

    Start job 

    Stop job 

4.3.2 Start a manual update 

You have various options for starting an update manually: When an update is started 
manually, the virus definition file and scan engine are always updated. A product update 
can only take place if you have activated the option Download and install product 
updates automatically in the configuration under PC protection > Update > Product 

update 

To start an update of your Avira product manually: 

  With the right-hand mouse button, click the Avira tray icon in the taskbar. 

  A context menu appears. 

  Select Start update. 

  The Updater dialog box appears. 

- OR - 

  In the Control Center, select Status. 

  In the Last update field, click on the Start update link. 
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  The Updater dialog box appears. 

- OR - 

  In the Control Center, in the Update menu, select the menu command Start update. 

  The Updater dialog box appears. 

Note 
We recommend regular automatic updates. The recommended update interval 
is: 6 hours. 

  

Note 
You can also carry out a manual update directly via the Windows security 

center. 

4.3.3 Using a scan profile to scan for viruses and malware 

A scan profile is a set of drives and directories to be scanned. 

The following options are available for scanning via a scan profile: 

Use predefined scan profile 

If the predefined scan profile corresponds to your requirements. 

Customize and apply scan profile (manual selection) 

If you want to scan with a customized scan profile. 

Depending on the operating system, various icons are available for starting a scan profile: 

 In Windows XP: 

  This icon starts the scan via a scan profile.  

 In Windows Vista: 

 In Microsoft Windows Vista, the Control Center only has limited rights at the moment, 
e.g. for access to directories and files. Certain actions and file accesses can only be 
performed in the Control Center with extended administrator rights. These extended 
administrator rights must be granted at the start of each scan via a scan profile. 

 This icon starts a limited scan via a scan profile. Only directories and files that 
Windows Vista has granted access rights to are scanned. 

 This icon starts the scan with extended administrator rights. After confirmation, all 
directories and files in the selected scan profile are scanned. 
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To scan for viruses and malware with a scan profile: 

  Go to Control Center and select the section PC PROTECTION >System Scanner. 

  Predefined scan profiles appear. 

  Select one of the predefined scan profiles. 

 -OR- 

 Adapt the scan profile Manual selection. 

  Click the icon (Windows XP:  or Windows Vista:   ). 

  The Luke Filewalker window appears and a system scan is started. 

  When the scan is completed, the results are displayed. 

If you want to adapt a scan profile: 

  In the scan profile, expand Manual Selection the file tree so that all the drives you 
want to scan are open: 

  Highlight the nodes you want to scan by clicking on the box  

4.3.4 Scan for viruses and malware using drag & drop 

To scan for viruses and malware systematically using drag & drop: 

  The Control Center of your Avira product has been opened. 

  Highlight the file you want to scan. 

  Use the left-hand mouse button to drag the highlighted file into the Control Center. 

  The Luke Filewalker window appears and a system scan is started. 

  When the scan is completed, the results are displayed. 

4.3.5 Scan for viruses and malware via the context menu 

To scan for viruses and malware systematically via the context menu: 

  Click with the right-hand mouse button (e.g. in Windows Explorer, on the desktop or 
in an open Windows directory) on the file you want to scan. 

  The Windows Explorer context menu appears. 

  Select Scan selected files with Avira in the context menu. 

  The Luke Filewalker window appears and a system scan is started. 

  When the scan is completed, the results are displayed. 



 Overview of Avira Free Antivirus 

Avira Free Antivirus - User Manual (Status: 24 Sep. 2012) 42 

4.3.6 Automatically scan for viruses and malware 

Note 
After installation, the scan job Full system scan is created in the Scheduler: A 

complete system scan is automatically performed at a recommended interval. 

To create a job to automatically scan for viruses and malware: 

  In the Control Center, select the section ADMINISTRATION > Scheduler. 

  Click the icon . 

  The dialog box Name and description of job appears. 

  Give the job a name and, where appropriate, a description. 

  Click Next. 

  The dialog box Type of job appears. 

  Select Scan job. 

  Click Next. 

  The dialog box Selection of the profile appears. 

  Select the profile to be scanned. 

  Click Next. 

  The dialog box Time of the job appears. 

  Select a time for the scan: 

 Immediately 

 Daily 

 Weekly 

 Interval 

 Single 

  Where appropriate, specify a date according to the selection. 

  Where appropriate, select the following additional options (availability depends on job 
type): 

Repeat job if the time has already expired 

Past jobs are performed that could not be performed at the required time, for example 
because the computer was switched off. 

  Click Next. 

  The dialog box Selection of the display mode appears. 

  Select the display mode of the job window: 

 Invisible: No job window 
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 Minimized: progress bar only 

 Maximized: Entire job window 

  Select the Shut down computer if job is done option if you want the computer to 
shut down automatically when the scan is finished. This option is only available if the 
display mode is set to minimized or maximized. 

  Click Finish. 

  Your newly created job appears on the start page of the ADMINISTRATION > 
Scheduler section with the status enabled (check mark). 

  Where appropriate, deactivate jobs that are not to be performed. 

Use the following icons to further define your jobs: 

    View properties of a job 

    Edit job 

    Delete job 

    Start job 

    Stop job 

4.3.7 Targeted scan for Rootkits and active malware 

To scan for active rootkits, use the predefined scan profile Scan for Rootkits and active 

malware. 

To scan for active rootkits systematically: 

  Go to Control Center and select the section PC PROTECTION > System Scanner. 

  Predefined scan profiles appear. 

  Select the predefined scan profile Scan for Rootkits and active malware. 

  Where appropriate, highlight other nodes and directories to be scanned by clicking 
the check box of the directory level. 

  Click the icon (Windows XP:  or Windows Vista:   ). 

  The Luke Filewalker window appears and a system scan is started. 

  When the scan is completed, the results are displayed. 
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4.3.8 React to detected viruses and malware 

For the individual protection components of your Avira product, you can define how your 
Avira product reacts to a detected virus or unwanted program in the Configuration under 
the section Action on detection. 

There are no configurable action options with the Real-Time Protection component. When 
a virus or unwanted program is detected, you will receive a desktop notification. In the 
desktop notification you can remove the detected malware or forward the  malware using 
the Details button to the System Scanner component for further virus management. The 
System Scanner opens a window containing notification of the detection, which gives you 
various options for managing the affected file via a context menu (see Detection > System 

Scanner): 

Action options for the System Scanner: 

Interactive 

In interactive action mode, the results of the System Scanner scan are displayed in a 
dialog box. This option is enabled as the default setting. 

In the case of System Scanner scan, you will receive an alert with a list of the 
affected files when the scan is complete. You can use the content-sensitive menu to 
select an action to be executed for the various infected files. You can execute the 
standard actions for all infected files or cancel the System Scanner. 

Automatic 

In automatic action mode, when a virus or unwanted program is detected the action 
you selected in this area is executed automatically.  

Action options for Web Protection: 

Interactive 

In interactive action mode, if a virus or unwanted program is detected, a dialog box 
appears in which you can select what to do with the infected object. This option is 

enabled as the default setting. 

Automatic 

In automatic action mode, when a virus or unwanted program is detected the action 

you selected in this area is executed automatically.  

In interactive action mode, you can react to detected viruses and unwanted programs by 
selecting an action for the infected object in the alert and executing the selected action by 
clicking Confirm. 

The following actions for handling infected objects are available for selection: 
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Note 
Which actions are available for selection depends on the operating system, the 
protection components (Avira Real-Time Protection, Avira Mail Protection, Avira 
Web Protection) reporting the detection, and the type of malware detected. 

Actions of the System Scanner: 

Repair 

The file is repaired. 

This option is only available if the infected file can be repaired. 

Rename 

The file is renamed with a *.vir extension. Direct access to these files (e.g. with double-

click) is therefore no longer possible. Files can be repaired and given their original 
name at a later time. 

Quarantine 

The file is packaged into a special format (*.qua) and moved to the Quarantine 
directory INFECTED on your hard disk, so that direct access is no longer possible. 

Files in this directory can be repaired in Quarantine at a later data or, if necessary, 

sent to Avira. 

Delete 

The file will be deleted. If a boot sector virus is detected, this can be deleted by 

deleting the boot sector. A new boot sector is written. 

Ignore 

No further action is taken. The infected file remains active on your computer. 

Warning 
This could result in loss of data and damage to the operating system! Only 
select the Ignore option in exceptional cases. 

Always ignore 

Action option for Real-Time Protection detections: No further action is taken by Real-
Time Protection. Access to the file is permitted. All further access to this file is 
permitted and no further notifications will be provided until the computer is restarted or 

the virus definition file is updated. 

Copy to quarantine 

Action option for a rootkits detection: The detection is copied to quarantine. 
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Repair boot sector | Download repair tool 

Action options when infected boot sectors are detected: A number of options are 
available for repairing infected diskette drives. If your Avira product is unable to 
perform the repair, you can download a special tool for detecting and removing boot 

sector viruses. 

Note 
If you carry out actions on running processes, the processes in question are 

terminated before the actions are performed. 

The website requested from the web server and/or any data or files transferred are 
moved to quarantine. The affected file can be recovered from quarantine manager if it 

has an informative value or - if necessary - sent to the Avira Malware Research 
Center. 

 

 

4.3.9 Handling quarantined files (*.qua) 

To handle quarantined files: 

  In the Control Center, select the section ADMINISTRATION > Quarantine section. 

  Check which files are involved, so that, if necessary, you can reload the original back 
onto your computer from another location. 

If you want to see more information on a file: 

  Highlight the file and click on  . 

  The dialog box Properties appears with more information on the file. 

If you want to rescan a file: 

Scanning a file is recommended if the virus definition file of your Avira product has been 
updated and a false positive report is suspected. This enables you to confirm a false 

positive with a rescan and restore the file. 

  Highlight the file and click on  . 

  The file is scanned for viruses and malware using the system scan settings. 

  After the scan, the dialog Rescan statistics appears which displays statistics on 
the status of the file before and after the rescan. 
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To delete a file: 

  Highlight the file and click on  . 

  You have to confirm your choice with Yes. 

If you want to upload the file to a Avira Malware Research Center web server for analysis: 

  Highlight the file you want to upload. 

  Click on   . 

  A dialog opens with a form for inputting your contact data. 

  Enter all the required data. 

  Select a type: Suspicious file or Suspicion of false positive. 

  Select a response format: HTML, Text, HTML & Text. 

  Click OK. 

  The file is uploaded to a Avira Malware Research Center web server in 
compressed form. 

Note 
In the following cases, analysis by the Avira Malware Research Center is 
recommended: 
Heuristic hits (Suspicious file): During a scan, a file has been classified as 
suspicious by your Avira product and moved to quarantine: Analysis of the file 
by the Avira Malware Research Center has been recommended in the virus 

detection dialog box or in the report file generated by the scan. 

  

Note 
The size of the files you upload is limited to 20 MB uncompressed or 8 MB 

compressed. 

  

Note 

You can only upload one file at a time.  

If you want to export the properties of a quarantined object to a text file: 

  Highlight the quarantined object and click on  . 

  The text file quarantaene - Notepad opens containing the data from the selected 
quarantined object. 
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  Save the text file. 

You can also restore the files in quarantine (see Chapter: Quarantine: Restoring files in 
quarantine). 

4.3.10 Restore the files in quarantine 

Different icons control the restore procedure, depending on the operating system: 

 In Windows XP: 

 This icon restores the files to their original directory. 

 This icon restores the files to a directory of your choice. 

 In Windows Vista: 

 In Microsoft Windows Vista, the Control Center only has limited rights at the moment, 
e.g. for access to directories and files. Certain actions and file accesses can only be 
performed in the Control Center with extended administrator rights. These extended 
administrator rights must be granted at the start of each scan via a scan profile. 

 This icon restores the files to a directory of your choice. 

 This icon restores the files to their original directory. If extended administrator 
rights are necessary to access this directory, a corresponding request appears. 

To restore files in quarantine: 

Warning 
This could result in loss of data and damage to the operating system of the 
computer! Only use the function Restore selected object in exceptional cases. 
Only restore files that could be repaired by a new scan. 

  File rescanned and repaired. 

  In the Control Center, select the section ADMINISTRATION > Quarantine section. 

Note 

Emails and email attachments can only be restored using the option  if the 
file extension is *.eml. 

To restore a file to its original location: 

  Highlight the file and click the icon (Windows XP:  , Windows Vista  ). 

This option is not available for emails. 
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Note 

Emails and email attachments can only be restored using the option  if the 
file extension is *.eml. 

  A message appears asking if you want to restore the file. 

  Click Yes. 

  The file is restored to the directory it was in before it was moved to quarantine. 

To restore a file to a specified directory: 

  Highlight the file and click on  . 

  A message appears asking if you want to restore the file. 

  Click Yes. 

  The Windows default window Save As for selecting the directory appears. 

  Select the directory to restore the file to and confirm. 

  The file is restored to the selected directory. 

4.3.11 Move suspicious files to quarantine 

To move a suspect file to quarantine manually: 

  In the Control Center, select the section ADMINISTRATION > Quarantine section. 

  Click on   . 

  The Windows default window for selecting a file appears. 

  Select the file and confirm with Open. 

  The file is moved to quarantine. 

You can scan files in quarantine with the Avira System Scanner (see Chapter: Quarantine: 

Handling quarantined files (*.qua)). 

4.3.12 Scan profile: Amend or delete file type in a scan profile 

To stipulate additional file types to be scanned or exclude specific file types from the scan 

in a scan profile (only possible for manual selection ): 

  In the Control Center, go to the PC PROTECTION > System Scanner section. 

  With the right-hand mouse button, click on the scan profile you want to edit. 

  A context menu appears. 

  Select File filter. 
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  Expand the context menu further by clicking on the small triangle on the right-hand 
side of the context menu. 

  The entries Default, Scan all files and User-defined appear. 

  Select User-defined. 

  The File extensions dialog box appears with a list of all file types to be scanned 
with the scan profile. 

If you want to exclude a file type from the scan: 

  Highlight the file type and click Delete. 

If you want to add a file type to the scan: 

  Highlight a file type. 

  Click Insert and enter the file extension of file type into the input box. 

Use a maximum of 10 characters and do not enter the leading dot. Wildcards (* 

and ? ) are allowed. 

4.3.13 Create desktop shortcut for scan profile 

You can start a system scan directly from your desktop via a desktop shortcut to a scan 

profile without accessing your Avira product’s Control Center. 

To create a desktop shortcut to the scan profile: 

  In the Control Center, go to the PC PROTECTION > System Scanner section. 

  Select the scan profile for which you want to create a shortcut. 

  Click the icon  . 

  The desktop shortcut is created. 

4.3.14 Filter events 

Events that have been generated by program components of your Avira product are 
displayed in the Control Center under ADMINISTRATION > Events (analogous to the 

event display of your Windows operating system). The program components, in 

alphabetical order, are the following: 

 Helper Service 

 Real-Time Protection 

 Scheduler 

 System Scanner 

 Updater 

 Web Protection 
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The following event types are displayed: 

 Information 

 Warning 

 Error 

 Detection 

To filter displayed events: 

  In the Control Center, select the section ADMINISTRATION > Events. 

  Check the box of the program components to display the events of the activated 
components. 

 - OR - 

 Uncheck the box of the program components to hide the events of the deactivated 
components. 

  Check the event type box to display these events. 

 - OR - 

 Uncheck the event type box to hide these events. 
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5. System Scanner 

With the System Scanner component, you can carry out targeted scans (on-demand 
scans) for viruses and unwanted programs. The following options are available for 
scanning for infected files: 

 System scan via context menu 
The system scan via the context menu (right-hand mouse button - entry Scan selected 
files with Avira) is recommended if, for example, you wish to scan individual files and 
directories. Another advantage is that it is not necessary to first start the Control Center 
for a system scan via the context menu. 

 System scan via drag & drop 
When a file or directory is dragged into the program window of the Control Center, the 
System Scanner scans the file or directory and all sub-directories it contains. This 
procedure is recommended if you wish to scan individual files and directories that you 
have saved, for example, on your desktop. 

 System scan via profiles 
This procedure is recommended if you wish to regularly scan certain directories and 
drives (e.g. your work directory or drives on which you regularly store new files). You do 
not then need to select these directories and drives again for every new scan, you 
simply select using the relevant profile.  

 System scan via the Scheduler 
The Scheduler enables you to carry out time-controlled scans. 

Special processes are required when scanning for rootkits, boot sector viruses, and when 
scanning active processes. The following options are available: 

 Scan for rootkits via the scan profile Scan for Rootkits and active malware 

 Scan active processes via the scan profile Active processes 

 Scan for boot sector viruses via the menu command Boot records scan... in the menu 
Extras 
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6. Updates 

The effectiveness of anti-virus software depends on how up-to-date the program is, in 
particular the virus definition file and the scan engine. To carry out regular updates, the 
Updater component is integrated into your Avira product. The Updater ensures that your 
Avira product is always up-to-date and able to deal with the new viruses that appear every 

day. Updater updates the following components: 

 Virus definition file: 

 The virus definition file contains the virus patterns of the harmful programs which are 
used by your Avira product to scan for viruses and malware and repair infected 
objects. 

 Scan engine: 

 The scan engine contains the methods used by your Avira product to scan for viruses 
and malware. 

 Program files (product update): 

 Update packages for product updates make extra functions available to the individual 
program components. 

An update checks whether the virus definition file and scan engine are up-to-date and if 
necessary implements an update. Depending on the settings in the configuration, the 
Updater also carries out a product update or informs you of the product updates available. 
After a product update, you may have to restart your computer system. If only the virus 
definition file and scan engine are updated, the computer does not have to be restarted. 

Note 
For security reasons, the Updater checks whether the Windows hosts file of 
your computer was altered, whether the Update URL, for example, was 
manipulated by malware and is diverting the Updater to unwanted download 
sites. If the Windows hosts file has been manipulated, this is shown in the 

Updater report file. 

An update is automatically performed in the following interval: 6 hours.  

In the Control Center under Scheduler, you can create additional update jobs that are 
performed by Updater at the specified intervals. You also have the option to start an 

update manually: 

 in the Control Center: in the Update menu and in the Status section 

 via the context menu of the tray icon 
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Updates can be obtained from the Internet via a Web server of the manufacturer. The 
existing network connection is the default connection to the download servers of Avira. 

You can change this default setting in the Configuration under General > Update. 
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7. FAQ, Tips 

This chapter contains important information on troubleshooting and further tips on using 

your Avira product. 

 see Chapter Help in case of a problem 

 see Chapter Shortcuts 

 see Chapter Windows Security Center  (Windows XP and Vista) or Windows Action 
Center (Windows 7)  

7.1 Help in case of a problem 

Here you will find information on causes and solutions of possible problems. 

 The error message Connection failed while downloading the file ... appears when 
attempting to start an update. 

 Viruses and malware cannot be moved or deleted. 

 The status of the tray icon is disabled. 

 The computer is extremely slow when I perform a data back-up. 

 My firewall reports Avira Real-Time Protection immediately after activation. 

 Webchat is not operational: Chat messages will not be displayed 

The error message Connection failed while downloading the file ... appears when 
attempting to start an update. 

Reason: Your Internet connection is inactive. No connection to the web server on the 
Internet can therefore be established. 

  Test whether other Internet services such as WWW or email work. If not, re-establish 
the Internet connection. 

Reason: The proxy server cannot be reached. 

  Check whether the login for the proxy server has changed and adapt it to your 
configuration if necessary. 

Reason: The update.exe file is not fully approved by your personal firewall. 

  Ensure that the update.exe file is fully approved by your personal firewall. 

Otherwise: 

  Check your settings in the Configuration (expert mode) under PC Protection > 
Update. 
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Viruses and malware cannot be moved or deleted. 

Reason: The file was loaded by windows and is active. 

  Update your Avira product. 

  If you use the Windows XP operating system, deactivate System Restore. 

  Start the computer in Safe Mode. 

  Start the Configuration of your Avira product (expert mode). 

  Select System Scanner > Scan > Files > All files and confirm the window with OK. 

  Start a scan of all local drives. 

  Start the computer in Normal Mode. 

  Carry out a scan in Normal Mode. 

  If no other viruses or malware have been found, activate System Restore if it is 
available and to be used. 

The status of the tray icon is disabled. 

Reason: Avira Real-Time Protection is disabled. 

  In the Control Center click Status and enable the Real-Time Protection in the PC 
Protection area . 

-OR- 

  Open the context menu with a right-click on the Tray Icon. Click Real-Time 
Protection enable. 

  

Reason: Avira Real-Time Protection is blocked by a firewall. 

  Define a general approval for Avira Real-Time Protection in the configuration of your 
firewall. Avira Real-Time Protection only works with the address 127.0.0.1 
(localhost). An Internet connection is not established.  

Otherwise: 

  Check the startup type of the Avira Real-Time Protection service. If necessary, 
enable the service: In the taskbar, select Start > Settings > Control Panel. Start the 
configuration panel Services with a double-click (under Windows XP the services 
applet is located in the sub-directory Administrative Tools). Find the entry Avira Real-

Time Protection. Automatic must be entered as the startup type and Started as 

the status. If necessary, start the service manually by selecting the relevant line and 
the button Start. If an error message appears, please check the event display. 
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The computer is extremely slow when I perform a data back-up. 

Reason: During the backup procedure, Avira Real-Time Protection scans all files being 

used by the backup procedure. 

  Select Real-Time Protection > Scan > Exceptions in the Configuration (expert 
mode) and enter the process names of the back-up software. 

My firewall reports Avira Real-Time Protection  

Reason: Communication with Avira Real-Time Protection occurs via the TCP/IP Internet 

protocol. A firewall monitors all connections via this protocol. 

  Define a general approval for Avira Real-Time Protection. Avira Real-Time Protection 
only works with the address 127.0.0.1 (localhost). An Internet connection is not 
established.  

Note 
We recommend regularly installing Microsoft updates to close any gaps in 

security. 

Webchat is not operational: Chat messages are not displayed; data are being loaded in 
the browser. 

This phenomenon may occur during chats, which are based on the HTTP protocol with 

'transfer-encoding: chunked’. 

Reason: Web Protection checks the sent data completely for viruses and undesired 
programs first, before the data are loaded into the web browser. During a data transfer 
with ‘transfer-encoding: chunked’, Web Protection cannot determine the message length 

or the data volume. 

  Enter the configuration of the URL of the web chats as an exception (see 
Configuration: Web Protection > Scan > Exceptions). 

7.2 Shortcuts 

Keyboard commands - also called shortcuts - offer a fast possibility to navigate through the 

program, to retrieve individual modules and to start actions. 

Below we provide you with an overview of the available keyboard commands. Please find 
further indications regarding the functionality in the corresponding chapter of the help. 
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7.2.1 In dialog boxes 

Shortcut Description 

Ctrl + Tab 
Ctrl + Page down 

Navigation in the Control Center 
Go to next section. 

Ctrl + Shift + Tab 
Ctrl + Page up 

Navigation in the Control Center 
Go to previous section. 

 

Navigation in the configuration sections 

First, use the mouse to set the focus on a configuration section. 

  

Change between the options in a marked drop-down list or 
between several options in a group of options. 

Tab Change to the next option or options group. 

Shift + Tab Change to the previous option or options group. 

Space Activate or deactivate a check box, if the active option is a 
check box. 

Alt + underlined 
letter 

Select option or start command. 

Alt + ↓ 

F4 

Open selected drop-down list. 

Esc Close selected drop-down list. 
Cancel command and close dialog. 

Enter Start command for the active option or button. 
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7.2.2 In the help 

Shortcut Description 

Alt + Space Display system menu. 

Alt + Tab Shift between the help and the other opened windows. 

Alt + F4 Close help. 

Shift + F10 Display context menu of the help. 

Ctrl + Tab Go to next section in the navigation window. 

Ctrl + Shift + Tab Go to previous section in the navigation window. 

Page up Change to the subject, which is displayed above in the contents, in 
the index or in the list of the search results. 

Page down Change to the subject, which is displayed below the current subject 
in the contents, in the index or in the list of the search results. 

Page up 
Page down 

Browse through a subject. 

7.2.3 In the Control Center 

General 

Shortcut Description 

F1 Display help 

Alt + F4 Close Control Center 

F5 Refresh 

F8 Open configuration 
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F9 Start update 

Scan section 

Shortcut Description 

F3 Start scan with the selected profile 

F4 Create desktop link for the selected profile 

Quarantine section 

Shortcut Description 

F2 Rescan object 

F3 Restore object 

F4 Send object 

F6 Restore object to... 

Return Properties 

Ins Add file 

Del Delete object 

Scheduler section 

Shortcut Description 

F2 Edit job 

Return Properties 
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Ins Insert new job 

Del Delete job 

Reports section 

Shortcut Description 

F3 Display report file 

F4 Print report file 

Return Display report 

Del Delete report(s) 

Events section 

Shortcut Description 

F3 Export event(s) 

Return Show event 

Del Delete event(s) 

7.3 Windows Security Center 

- Windows XP Service Pack 2 or higher - 

7.3.1 General 

The Windows Security Center checks the status of a computer for important security 

aspects. 

If a problem is detected with one of these important points (e.g. an outdated anti-virus 
program), the Security Center issues an alert and gives recommendations on how to 
protect your computer better. 
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7.3.2 The Windows Security Center and your Avira product 

Virus protection software / Protection against malicious software 

You may receive the following information from the Windows Security Center with regard 
to your virus protection: 

 Virus protection NOT FOUND 

 Virus protection OUT OF DATE 

 Virus protection ON 

 Virus protection OFF 

 Virus protection NOT MONITORED 

Virus protection NOT FOUND 

This information of the Windows Security Center appears when the Windows Security 

Center has not found any anti-virus software on your computer. 

 

Note 
Install your Avira product on your computer to protect it against viruses and 
other unwanted programs! 

Virus protection OUT OF DATE 

If you have already installed Windows XP Service Pack 2 or Windows Vista and then 
install your Avira product or you install Windows XP Service Pack 2 or Windows Vista on a 
system on which your Avira product has already been installed, you will receive the 

following message: 
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Note 
In order for the Windows Security Center to recognize your Avira product as up-
to-date, an update must be performed after installation. Update your system by 
carrying out an update. 

Virus protection ON 

After installing your Avira product and performing a subsequent update, you will receive 

the following message: 

 

Your Avira product is now up-to-date and the Avira Real-Time Protection is enabled. 

Virus protection OFF 

You receive the following message if you disable the Avira Real-Time Protection or stop 

the Real-Time Protection service. 

 

Note 
You can enable or disabled Avira Real-Time Protection in the Status section of 
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the Control Center. You can also see that the Avira Real-Time Protection is 
enabled if the red umbrella in your taskbar is open. 

Virus protection NOT MONITORED 

If you receive the following message from the Windows Security Center, you have decided 

that you want to monitor your anti-virus software yourself. 

 

Note 
This function is not supported by Windows Vista. 

Note 
The Windows Security Center is supported by your Avira product. You can 

enable this option at any time via the Recommendations button. 

  

Note 
Even if you have installed Windows XP Service Pack 2 or Windows Vista, you 
still require a virus protection solution. Although Windows monitors your anti-
virus software, it does not contain any anti-virus functions itself. Therefore you 
would not be protected against viruses and other malware without an additional 
anti-virus solution! 

7.4 Windows Action Center 

- Windows 7 - 

7.4.1 General 

Note: 
In Windows 7 the Windows Security Center has been renamed to Windows 
Action Center. Under this section you will find the status of all your security 

options. 
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The Windows Action Center checks the status of a computer for important security 
aspects. You can access it directly by clicking the little flag in your taskbar or under 

Control Panel > Action Center. 

If a problem is detected with one of these important points (e.g. an outdated anti-virus 
program), the Action Center issues an alert and gives recommendations on how to protect 
your computer better. This means, that if everything works correctly, you won't be bothered 
with messages. You still can have a look at the security status of your computer in the 
Windows Action Center, under the Security item. 
The Windows Action Center also gives you the option of managing the installed 
programs and to choose between them (e.g. View installed antispyware programs). 

You can even turn off the warning messages under Change Action Center settings (e.g. 
Turn off messages about spyware and related protection). 

7.4.2 The Windows Action Center and your Avira product 

Virus protection software 

You may receive the following information from the Windows Action Center with regard to 
your virus protection: 

Virus protection 

 Avira Desktop reports that it is UP TO DATE and virus scanning is ON.  

 Avira Desktop reports that virus scanning is temporarily TURNED OFF. 

 Avira Desktop reports that it is OUT OF DATE. 

 Windows DID NOT FIND antivirus software on this computer. 

Avira Desktop reports that it is UP TO DATE and virus scanning is ON 

After installation of your Avira product and a subsequent update, you will not receive any 
messages from the Windows Action Center. But if you go to  Action Center > Security 
you can see: Avira Desktop reports that it is up to date and virus scanning is on. This 

means that your Avira product is now up-to-date and the Avira Real-Time Protection is 
enabled. 

Avira Desktop reports that virus scanning is temporarily TURNED OFF 

You receive the following message if you disable the Avira Real-Time Protection or stop 
the Real-Time Protection service.  
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Note 
You can enable or disable Avira Real-Time Protection in the Status section of 
the Avira Control Center. You can also see that the Avira Real-Time 
Protection is enabled if the red umbrella in your taskbar is open. It is also 
possible to activate the Avira product by clicking the Turn on now button on the 

Windows Action Center message. You will receive a notification asking your 
permission to run Avira. Click on Yes, I trust the publisher and want to run this 

program and Real-Time Protection will be enabled again. 

Avira Desktop reports that it is OUT OF DATE 

If you install your Avira product on Windows 7 or if you upgrade an older Windows 
operating system, on which your Avira product is already installed, to Windows 7, then you 

will receive the following message: 

 

Note 
In order for the Windows Action Center to recognize your Avira product as up-
to-date, an update must be performed after installation. Update your Avira 

Product by carrying out an update. 

Windows DID NOT FIND antivirus software on this computer  

This information of the Windows Action Center appears, when the Windows Action Center 
has not found any anti-virus software on your computer.  
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Note 
Install your Avira product on your computer to protect it against viruses and 

other unwanted programs! 

Spyware and unwanted software protection 

You may receive the following information from the Windows Action Center with regard to 

your spyware protection: 

Spyware and unwanted software protection 

 Avira Desktop reports that it is TURNED ON. 

 Avira Desktop reports that it is temporarily TURNED OFF. 

 Windows Defender is OUT OF DATE. 

 Windows Defender is TURNED OFF. 

Avira Desktop reports that it is TURNED ON 

After the installation of your Avira product and a subsequent update, you will not receive 
any messages from the Windows Action Center. But if you go to Action Center > 
Security, you can see: Avira Desktop reports that it is turned on. This means that your 

Avira product is now up-to-date and the Avira Real-Time Protection is enabled. 

Avira Desktop reports that it is TURNED OFF 

You receive the following message if you disable the Avira Real-Time Protection or stop 

the Real-Time Protection service.  

 

Note 
You can enable or disable Avira Real-Time Protection in the Status section of 
the Avira Control Center. You can also see that the Avira Real-Time 
Protection is enabled if the red umbrella in your taskbar is open. It is also 
possible to activate the Avira product by clicking the Turn on now button on the 
Windows Action Center message. You will receive a notification asking your 
permission to run Avira. Click on Yes, I trust the publisher and want to run this 

program and Real-Time Protection will be enabled again. 
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Windows Defender is OUT OF DATE 

You receive the following message if Windows Defender is activated. If you have already 
installed the Avira product, this message should not appear. Please check if the 
installation went OK. 

 

Note 
Windows Defender is the spyware solution from Windows. It is included and 

enabled by default in Windows Vista and Windows 7. 

Windows Defender is TURNED OFF 

This information of the Windows Action Center appears when the Windows Action Center 
has not found any other anti-virus software on your computer than the one that the 
operating system integrates by default: Windows Defender. If you have had some anti-
virus software installed on your computer before, this application has been disabled. If you 
have already installed the Avira product, this message should not appear: Avira should be 

automatically detected. Please check if the installation went OK. 

 
  

Note 
Even if you have installed Windows 7, you still require a virus protection 
solution. Although Windows monitors your anti-virus software, it only contains 
Windows Defender and Windows Firewall. They only protect you against some 
intrusions and spyware. Therefore you would not be protected against viruses 

and other malware without an additional anti-virus solution! 
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8. Viruses and more 

Avira Free Antivirus not only detects viruses and malware, it can also protect you from 
other threats. In this chapter you can find an overview of different kinds of malware and 
other threats describing their background, behavior and the unpleasant surprises they 

have in store for you. 

Related topics: 

 Threat categories 

 Viruses and other malware 

8.1 Threat categories 

Adware 

Adware is software that presents banner ads or in pop-up windows through a bar that 
appears on a computer screen. These advertisements usually cannot be removed and are 
consequently always visible. The connection data allow many conclusions on the usage 

behavior and are problematic in terms of data security. 

Your Avira product detects Adware. If the Adware option is enabled with a check mark in 
the configuration under Threat categories, you receive a corresponding alert if your Avira 
product detects adware. 

Adware/Spyware 

Software that displays advertising or software that sends the user’s personal data to a third 

party, often without their knowledge or consent, and for this reason may be unwanted. 

Your Avira product recognizes "Adware/Spyware". If the option Adware/Spyware is 
enabled with a check mark in the configuration under Threat categories, you receive a 

corresponding alert if your Avira product detects adware or spyware. 

Application 

The term APPL, respectively application, refers to an application which may involve a risk 

when used or is of dubious origin. 

Your Avira product recognizes "Application (APPL)". If the option Application is enabled 
with a check mark in the configuration under Threat categories, you receive a 

corresponding alert if your Avira product detects such behavior. 
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Backdoor Clients 

In order to steal data or manipulate computers, a backdoor server program is smuggled in 
unknown to the user. This program can be controlled by a third party using backdoor 

control software (client) via the Internet or a network. 

Your Avira product recognizes "Backdoor control software". If the Backdoor control 
software option is enabled with a check mark in the configuration under Threat categories, 
you receive a corresponding alert if your Avira product detects such software. 

Dialer 

Certain services available in the Internet have to be paid for. They are invoiced in 
Germany via dialers with 0190/0900 numbers (or via 09x0 numbers in Austria and 

Switzerland; in Germany, the number is set to change to 09x0 in the medium term). Once 
installed on the computer, these programs guarantee a connection via a suitable premium 

rate number whose scale of charges can vary widely. 

The marketing of online content via your telephone bill is legal and can be of advantage to 
the user. Genuine dialers leave no room for doubt that they are used deliberately and 
intentionally by the user. They are only installed on the user’s computer subject to the 
user’s consent, which must be given via a completely unambiguous and clearly visible 
labeling or request. The dial-up process of genuine dialers is clearly displayed. Moreover, 

genuine dialers tell you the incurred costs exactly and unmistakably. 

Unfortunately there are also dialers which install themselves on computers unnoticed, by 
dubious means or even with deceptive intent. For example they replace the Internet user’s 
default data communication link to the ISP (Internet Service Provider) and dial a cost-
incurring and often horrendously expensive 0190/0900 number every time a connection is 
made. The affected user will probably not notice until his next phone bill that an unwanted 
0190/0900 dialer program on his computer has dialed a premium rate number with every 

connection, resulting in dramatically increased costs. 

We recommend that you ask your telephone provider to block this number range directly 
for immediate protection against undesired dialers (0190/0900 dialers). 

Your Avira product can detect the familiar dialers by default. 

If the option Dialers is enabled with a check mark in the configuration under Threat 
categories, you receive a corresponding alert if a dialer is detected. You can now simply 

delete the potentially unwanted 0190/0900 dialer. However, if it is a wanted dial-up 
program, you can declare it an exceptional file and this file is then no longer scanned in 
future. 

Double Extension Files 

Executable files that hide their real file extension in a suspicious way. This camouflage 

method is often used by malware. 
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Your Avira product recognizes "Double Extension Files". If the option Double Extension 
files is enabled with a check mark in the configuration under Threat categories, you 

receive a corresponding alert if your Avira product detects such files. 

Fraudulent software 

Also known as "scareware" or "rogueware", it is a fraudulent software that pretends that 
your computer is infected by viruses or malware. This software looks deceptively similar to 
professional antivirus software but is meant to raise uncertainty or to scare the user. Its 
purpose is to make the victims feel threatened of imminent (unreal) danger and to make 
them pay to eliminate it. There are also cases when the victims are lead to believe they 
were attacked and they are instructed to carry out an action, which in reality is the real 

attack. 

Your Avira product detects scareware. If the option Fraudulent software is enabled with a 
check mark in the configuration Threat categories, you receive a corresponding alert if 

your Avira product detects such files. 

Games 

There is a place for computer games - but it is not necessarily at work (except perhaps in 
the lunch hour). Nevertheless, with the wealth of games downloadable from the Internet, a 
fair bit of mine sweeping and Patience playing goes on among company employees and 
civil servants. You can download a whole array of games via the Internet. Email games 
have also become more popular: numerous variants are circulating, ranging from simple 
chess to "fleet exercises" (including torpedo combats): The corresponding moves are sent 

to partners via email programs, who answer them. 

Studies have shown that the number of working hours devoted to computer games has 
long reached economically significant proportions. It is therefore not surprising that more 
and more companies are considering ways of banning computer games from workplace 

computers. 

Your Avira product recognizes computer games. If the Games option is enabled with a 
check mark in the configuration under Threat categories, you receive a corresponding alert 
if your Avira product detects a game. The game is now over in the truest sense of the 
word, because you can simply delete it. 

Jokes 

Jokes are merely intended to give someone a fright or provide general amusement without 
causing harm or reproducing. When a joke program is loaded, the computer will usually 
start at some point to play a tune or display something unusual on the screen. Examples of 
jokes are the washing machine in the disk drive (DRAIN.COM) or the screen eater 

(BUGSRES.COM). 

But beware! All symptoms of joke programs may also originate from a virus or Trojan. At 
the very least users will get quite a shock or be thrown into such a panic that they 

themselves may cause real damage. 
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Thanks to the extension of its scanning and identification routines, your Avira product is 
able to detect joke programs and eliminate them as unwanted programs if required. If the 
option Jokes is enabled with a check mark in the configuration under Threat categories, a 

corresponding alert is issued if a joke program is detected. 

Phishing 

Phishing, also known as "brand spoofing" is a clever form of data theft aimed at customers 
or potential customers of Internet service providers, banks, online banking services, 
registration authorities. 
When submitting your email address on the Internet, filling in online forms, accessing 
newsgroups or websites, your data can be stolen by "Internet crawling spiders" and then 

used without your permission to commit fraud or other crimes. 

Your Avira product recognizes "Phishing". If the option Phishing is enabled with a check 
mark in the configuration under Threat categories, you receive a corresponding alert if 

your Avira product detects such behavior. 

Programs that violate the private domain 

Software that may be able to compromise the security of your system, initiate unwanted 
program activities, damage your privacy or spy on your user behavior and could therefore 

be unwanted. 

Your Avira product detects "Security Privacy Risk" software. If the option Programs that 
violate the private domain is enabled with a check mark in the configuration under 
Threat categories, you receive a corresponding alert if your Avira product detects such 
software. 

Unusual Runtime Packers 

Files that have been compressed with an unusual runtime packer and that can therefore 

be classified as potentially suspicious. 

Your Avira product recognizes "Unusual runtime packers". If the option Unusual runtime 
packers is enabled with a check mark in the configuration under Threat categories, you 

receive a corresponding alert if your Avira product detects such packers. 

8.2 Viruses and other malware 

Adware 

Adware is software that presents banner ads or in pop-up windows through a bar that 
appears on a computer screen. These advertisements usually cannot be removed and are 
consequently always visible. The connection data allow many conclusions on the usage 
behavior and are problematic in terms of data security. 
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Backdoors 

A backdoor can gain access to a computer by bypassing the computer access security 

mechanisms. 

A program that is being executed in the background generally enables the attacker almost 
unlimited rights. User's personal data can be spied with the backdoor's help.. But are 
mainly used to install further computer viruses or worms on the relevant system. 

Boot viruses 

The boot or master boot sector of hard disks is mainly infected by boot sector viruses. 
They overwrite important information necessary for the system execution. One of the 

awkward consequences: the computer system cannot be loaded any more… 

Bot-Net 

A bot-net is defined as a remote network of PCs (on the Internet) that is composed of bots 
that communicate with each other. A bot-net can comprise a collection of cracked 
machines running programs (usually referred to as worms, Trojans) under a common 
command and control infrastructure. Bot-nets serve various purposes, including denial-of-
service attacks etc., usually without the affected PC user's knowledge. The main potential 
of bot-nets is that the networks can achieve grow to thousands of computers and their total 

bandwidth exceeds most conventional Internet accesses. 

Exploit 

An exploit (security gap) is a computer program or script that takes advantage of a bug, 
glitch or vulnerability leading to privilege escalation or denial of service on a computer 
system. One form of exploitation for example is an attack from the Internet with the help of 

manipulated data packages. Programs can be infiltrated in order to obtain higher access. 

Fraudulent software 

Also known as "scareware" or "rogueware", it is a fraudulent software that pretends that 
your computer is infected by viruses or malware. This software looks deceptively similar to 
professional Antivirus software but is meant to raise uncertainty or to scare the user. Its 

purpose is to make the victims feel threatened of imminent (unreal) danger and to make 
them pay to eliminate it. There are also cases when the victims are lead to believe they 
were attacked and they are instructed to carry out an action, which in reality is the real 

attack. 
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Hoaxes 

For several years, Internet and other network users have received alerts about viruses that 
are purportedly spread via email. These alerts are spread via email with the request that 
they should be sent to the highest possible number of colleagues and to other users, in 

order to warn everyone against the "danger". 

Honeypot 

A honeypot is a service (program or server) installed in a network. Its function is to monitor 
a network and log attacks. This service is unknown to the legitimate user - because of this 
reason he is never addressed. If an attacker examines a network for the weak points and 

uses the services which are offered by a honeypot, it is logged and an alert is triggered. 

Macro viruses 

Macro viruses are small programs that are written in the macro language of an application 
(e.g. WordBasic under WinWord 6.0) and that can normally only spread within documents 
of this application. Because of this, they are also called document viruses. In order to be 
active, they need that the corresponding applications are activated and that one of the 
infected macros has been executed. Unlike "normal" viruses, macro viruses consequently 
do not attack executable files but they do attack the documents of the corresponding host 

application. 

Pharming 

Pharming is a manipulation of the host file of web browsers to divert enquiries to spoofed 
websites. This is a further development of classic phishing. Pharming fraudsters operate 
their own large server farms on which fake websites are stored. Pharming has established 
itself as an umbrella term for various types of DNS attacks. In the case of a manipulation 
of the host file, a specific manipulation of a system is carried out with the aid of a Trojan or 
virus. The result is that the system can now only access fake websites, even if the correct 

web address is entered. 

Phishing 

Phishing means angling for personal details of the Internet user. Phishers generally send 

their victims apparently official letters such as emails that are intended to induce them to 
reveal confidential information to the culprits in good faith, in particular user names and 
passwords or PINs and TANs of online banking accounts. With the stolen access details, 
the phishers can assume the identities of the victims and carry out transactions in their 
name. What is clear is that: banks and insurance companies never ask for credit card 

numbers, PINs, TANs or other access details by email, SMS or telephone. 
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Polymorph viruses 

Polymorph viruses are the real masters of disguise. They change their own programming 

codes - and are therefore very hard to detect. 

Program viruses 

A computer virus is a program that is capable of attaching itself to other programs after 
being executed and cause an infection. Viruses multiply themselves unlike logic bombs 
and Trojans. In contrast to a worm, a virus always requires a program as host, where the 
virus deposits its virulent code. The program execution of the host itself is not changed as 
a rule. 

Rootkits 

A rootkit is a collection of software tools that are installed after a computer system has 
been infiltrated to conceal logins of the infiltrator, hide processes and record data - 
generally speaking: to make themselves invisible. They attempt to update already installed 
spy programs and reinstall deleted spyware. 

Script viruses and worms 

Such viruses are extremely easy to program and they can spread - if the required 
technology is on hand - within a few hours via email round the globe. 

Script viruses and worms use one of the script languages, such as Javascript, VBScript 
etc., to insert themselves in other, new scripts or to spread themselves by calling operating 
system functions. This frequently happens via email or through the exchange of files 
(documents). 

A worm is a program that multiplies itself but that does not infect the host. Worms cannot 
consequently form part of other program sequences. Worms are often the only possibility 

to infiltrate any kind of damaging programs on systems with restrictive security measures. 

Spyware 

Spyware are so called spy programs that intercept or take partial control of a computer's 

operation without the user's informed consent. Spyware is designed to exploit infected 
computers for commercial gain. 

Trojan horses (short Trojans) 

Trojans are pretty common nowadays. Trojans include programs that pretend to have a 
particular function, but that show their real image after execution and carry out a different 
function that, in most cases, is destructive. Trojan horses cannot multiply themselves, 
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which differentiates them from viruses and worms. Most of them have an interesting name 
(SEX.EXE or STARTME.EXE) with the intention to induce the user to start the Trojan. 
Immediately after execution they become active and can, for example, format the hard 
disk. A dropper is a special form of Trojan that 'drops' viruses, i.e. embeds viruses on the 
computer system. 

Zombie 

A zombie PC is a computer that is infected with malware programs and that enables 
hackers to abuse computers via remote control for criminal purposes. On command, the 
affected PC starts denial-of-service (DoS) attacks, for example, or sends spam and 
phishing emails. 
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9. Info and Service 

This chapter contains information on how to contact us. 

 see Chapter Contact address 

 see Chapter Technical support 

 see Chapter Suspicious files 

 see Chapter Report false positives 

9.1 Contact address 

If you have any questions or requests concerning the Avira product range, we will be 
pleased to help you. For our contact addresses, please refer to the Control Center under 

Help > About Avira Free Antivirus. 

9.2 Technical support 

Avira support provides reliable assistance in answering your questions or solving a 
technical problem. 

All necessary information on our comprehensive support service can be obtained from our 
website: 

 http://www.avira.com/personal-support 

So that we can provide you with fast, reliable help, you should have the following 
information ready: 

 Version information. You can find this information in the program interface under the 
menu item Help > About Avira Free Antivirus > Version information. See Version 
information. 

 Operating system version and any Service Packs installed. 

 Installed software packages, e.g. anti-virus software of other vendors. 

 Exact messages of the program or of the report file. 

9.3 Suspicious file 

Suspect files or viruses that may not yet be detected or removed by our products can be 

sent to us. We provide you with several ways of doing this. 

http://www.avira.com/personal-support
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 Identify the file in the quarantine manager of the Control Center and select the item 
Send file via the context menu or the corresponding button. 

 Send the required file packed (WinZIP, PKZip, Arj, etc.) in the attachment of an email to 
the following address: 
virus-personal@avira.com 
As some email gateways work with anti-virus software, you should also provide the 
file(s) with a password (please remember to tell us the password). 

9.4 Reporting false positives 

If you believe that your Avira product is reporting a detection in a file that is most likely 
"clean", send the relevant file packed (WinZIP, PKZip, Arj, etc.) as an email attachment to 

the following address: 

virus-personal@avira.com 

As some email gateways work with anti-virus software, you should also provide the file(s) 
with a password (please remember to tell us the password). 

mailto:virus-personal@avira.com
mailto:virus-personal@avira.com
mailto:virus-personal@avira.com
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10. Reference: Configuration options 

The configuration reference documents all available configuration options. 

10.1 System Scanner 

The System Scanner section of configuration is responsible for the configuration of the 

on-demand scan. (Options available in expert mode only.) 

10.1.1 Scan 

You can define the behavior of the on-demand scan routine (options available in expert 
mode only). If you select certain directories to be scanned, depending on the configuration, 

the System Scanner scans: 

 with a certain scanning priority, 

 also boot sectors and main memory, 

 all or selected files in the directory. 

Files 

The System Scanner can use a filter to scan only those files with a certain extension 
(type). 

All files 

If this option is enabled, all files are scanned for viruses or unwanted programs, 
irrespective of their content and file extension. The filter is not used. 

Note 

If All files is enabled, the button File extensions cannot be selected. 

Use smart extensions 

If this option is enabled, the selection of the files scanned for viruses or unwanted 
programs is automatically chosen by the program. This means that your Avira program 

decides whether the files are scanned or not based on their content. This procedure is 
somewhat slower than Use file extension list, but more secure, since not only on the 
basis of the file extension is scanned. This option is enabled as the default setting and 

is recommended. 
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Note 
If Use smart extensions is enabled, the button File extensions cannot be 

selected. 

Use file extension list 

If this option is enabled, only files with a specified extension are scanned. All file types 
that may contain viruses and unwanted programs are preset. The list can be edited 

manually via the button "File extension". 

Note 
If this option is enabled and you have deleted all entries from the list with file 
extensions, this is indicated with the text "No file extensions" under the button 

File extensions. 

File extensions 

With the aid of this button, a dialog box is opened in which all file extensions are 
displayed that are scanned in "Use file extension list" mode. Default entries are set 

for the extensions, but entries can be added or deleted. 

Note 
Please note that the default list may vary from version to version. 

Additional settings 

Scan boot sectors of selected drives 

If this option is enabled, the System Scanner scans the boot sectors of the drives 

selected for the system scan. This option is enabled as the default setting. 

Scan master boot sectors 

If this option is enabled, the System Scanner scans the master boot sectors of the 

hard disk(s) used in the system. 

Ignore offline files 

If this option is enabled, the direct scan ignores so-called offline files completely during 

a scan. This means that these files are not scanned for viruses and unwanted 
programs. Offline files are files that were physically moved by a so-called Hierarchical 
Storage Management System (HSMS) from the hard disk onto a tape, for example. 

This option is enabled as the default setting. 

Integrity checking of system files 

When this option is enabled, the most important Windows system files are subjected to 
a particularly secure check for changes by malware during every on-demand scan. If 
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an amended file is detected, this is reported as suspect. This function uses a lot of 
computer capacity. That is why the option is disabled as the default setting. 

Note 

This option is only available with Windows Vista and higher. 

  

Note 
This option should not be used if you are using third-party tools that modify 
system files and adapt the boot or start screen to your own requirements. 
Examples of such tools are skinpacks, TuneUp utilities or Vista Customization. 

Optimized scan 

When the option is enabled, the processor capacity is optimally utilized during a 
System Scanner scan. For performance reasons, an optimized scan is only logged on 
standard level. 

Note 

This option is only available on multi-processor systems.  

  

Follow symbolic links 

If this option is enabled, System Scanner performs a scan that follows all symbolic 
links in the scan profile or selected directory and scans the linked files for viruses and 

malware. 

Note 
The option does not include any shortcuts, but refers exclusively to symbolic 
links (generated by mklink.exe) or Junction Points (generated by junction.exe) 

that are transparent in the file system. 

Search for Rootkits before scan 

If this option is enabled and a scan is started, the System Scanner scans the Windows 
system directory for active rootkits in a so-called shortcut. This process does not scan 
your computer for active rootkits as comprehensively as the scan profile "Scan for 

rootkits", but it is significantly quicker to perform. 

Note 
The rootkits scan is not available for Windows XP 64 bit !  

  



 Reference: Configuration options 

Avira Free Antivirus - User Manual (Status: 24 Sep. 2012) 82 

Scan Registry 

If this option is enabled, the Registry is scanned for references to malware. 

Scan process 

Allow stopping the Scanner 

If this option is enabled, the scan for viruses or unwanted programs can be terminated 
at any time with the button "Stop" in the "Luke Filewalker" window. If you have 
disabled this setting, the Stop button in the "Luke Filewalker" window has a gray 
background. Premature ending of a scan process is thus not possible! This option is 

enabled as the default setting. 

Scanner priority 

With the on-demand scan, the System Scanner distinguishes between priority levels. 
This is only effective if several processes are running simultaneously on the 

workstation. The selection affects the scanning speed. 

low 

The System Scanner is only allocated processor time by the operating system, if no 
other process requires computation time, i.e. as long as only the System Scanner is 
running, the speed is maximum. All in all, work with other programs is optimal: The 
computer responds more quickly if other programs require computation time while the 

System Scanner continues running in the background. 

normal 

The System Scanner is executed with normal priority. All processes are allocated the 
same amount of processor time by the operating system. This option is enabled as the 
default setting and is recommended. Under certain circumstances, work with other 

applications may be affected. 

high 

The System Scanner has the highest priority. Simultaneous work with other 
applications is almost impossible. However, the System Scanner completes its scan at 

maximum speed. 

Action on detection 

You can define the actions to be performed by System Scanner when a virus or unwanted 
program is detected. (Options available in expert mode only.) 

Interactive 

If this option is enabled, the results of the System Scanner scan are displayed in a 
dialog box. When carrying out a scan with the System Scanner, you will receive an 
alert with a list of the affected files at the end of the scan. You can use the content-
sensitive menu to select an action to be executed for the various infected files. You 
can execute the standard actions for all infected files or cancel the System Scanner. 



 Reference: Configuration options 

Avira Free Antivirus - User Manual (Status: 24 Sep. 2012) 83 

Note 
The action Quarantine is preselected by default in the System Scanner 

notification. Further actions can be selected via a context menu. 

Automatic 

If this option is enabled, no dialog box in case of a virus detection appears. The 
System Scanner reacts according to the settings you predefine in this section as 

primary and secondary action. 

Copy file to quarantine before action 

If this option is enabled, the System Scanner creates a backup copy before carrying 
out the requested primary or secondary action. The back-up copy is saved in 
Quarantine, where the file can be restored if it is of informative value. You can also 

send the backup copy to the Avira Malware Research Center for further investigation. 

Primary action 

Primary action is the action performed when the System Scanner finds a virus or an 
unwanted program. If the option "Repair" is selected but the affected file cannot be 
repaired, the action selected under "Secondary action" is performed. 

Note 
The option Secondary action can only be selected if the setting Repair was 

selected under Primary action. 

Repair 

If this option is enabled, the System Scanner repairs affected files automatically. If the 
System Scanner cannot repair an affected file, it carries out the action selected under 

Secondary action. 

Note 
An automatic repair is recommended, but means that the System Scanner 

modifies files on the workstation. 

Rename 

If this option is enabled, the System Scanner renames the file. Direct access to these 
files (e.g. with double-click) is therefore no longer possible. Files can later be repaired 

and given their original names again. 

Quarantine 

If this option is enabled, the System Scanner moves the file to the quarantine. These 
files can later be repaired or - if necessary - sent to the Avira Malware Research 

Center. 
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Delete 

If this option is enabled, the file is deleted.  

Ignore 

If this option is enabled, access to the file is allowed and the file is left as it is. 

Warning 
The affected file remains active on your workstation! It may cause serious 

damage on your workstation! 

Secondary action 

The option "Secondary action" can only be selected if the setting Repair was 

selected under "Primary action". With this option it can now be decided what is to be 
done with the affected file if it cannot be repaired. 

Rename 

If this option is enabled, the System Scanner renames the file. Direct access to these 
files (e.g. with double-click) is therefore no longer possible. Files can later be repaired 

and given their original names again. 

Quarantine 

If this option is enabled, the System Scanner moves the file to Quarantine. These files 
can later be repaired or - if necessary - sent to the Avira Malware Research Center. 

Delete 

If this option is enabled, the file is deleted.  

Ignore 

If this option is enabled, access to the file is allowed and the file is left as it is. 

Warning 
The affected file remains active on your workstation! It may cause serious 

damage on your workstation! 

Note 
If you have selected Delete or as the primary or secondary action, you should 

note the following: In the case of heuristic hits, the affected files are not deleted, 
but are instead moved to quarantine. 

Archives 

When scanning archives, the System Scanner uses a recursive scan: Archives in archives 
are also unpacked and scanned for viruses and unwanted programs. The files are 

scanned, decompressed and scanned again. (Options available in expert mode only.) 



 Reference: Configuration options 

Avira Free Antivirus - User Manual (Status: 24 Sep. 2012) 85 

Scan archives 

If this option is enabled, the selected archives in the archive list are scanned. This 
option is enabled as the default setting. 

All archive types 

If this option is enabled, all archive types in the archive list are selected and scanned. 

Smart Extensions 

If this option is enabled, the System Scanner detects whether a file is a packed file 
format (archive), even if the file extension differs from the usual extensions, and scans 
the archive. However every file must be opened for this, which reduces the scanning 
speed. Example: If a *.zip archive has the file extension *.xyz, the System Scanner 

also unpacks this archive and scans it. This option is enabled as the default setting. 

Note 
Only those archive types marked in the archive list are supported. 

Limit recursion depth 

Unpacking and scanning recursive archives can require a great deal of computer time 
and resources. If this option is enabled, you limit the depth of the scan in multi-packed 
archives to a certain number of packing levels (maximum recursion depth). This saves 

time and computer resources. 

Note 
In order to find a virus or an unwanted program in an archive, the System 
Scanner must scan up to the recursion level in which the virus or the unwanted 

program is located. 

Maximum recursion depth 

In order to enter the maximum recursion depth, the option Limit recursion depth must 
be enabled. 
You can either enter the requested recursion depth directly or by means of the right 
arrow key on the entry field. The permitted values are 1 to 99. The standard value is 
20 which is recommended. 

Default values 

The button restores the pre-defined values for scanning archives. 

Archives 

In this display area you can set which archives the System Scanner should scan. For 

this, you must select the relevant entries. 
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Exceptions 

File objects to be omitted for the System Scanner (Options available in expert mode only.) 

The list in this window contains files and paths that should not be included by the System 
Scanner in the scan for viruses or unwanted programs. 

Please enter as few exceptions as possible here and really only files that, for whatever 
reason, should not be included in a normal scan. We recommend that you always scan 

these files for viruses or unwanted programs before they are included in this list! 

Note 

The entries in the list must not result in more than 6000 characters in total. 

Warning 

These files are not included in a scan! 

Note 
The files included in this list are recorded in the report file. Please check the 
report file from time to time for unscanned files, as perhaps the reason you 
excluded a file here no longer exists. In this case you should remove the name 

of this file from this list again. 

Input box 

In this input box you can enter the name of the file object that is not included in the on-

demand scan. No file object is entered as the default setting. 

 

The button opens a window in which you can select the required file or the required 
path. 
When you have entered a file name with its complete path, only this file is not scanned 
for infection. If you have entered a file name without a path, all files with this name 
(irrespective of the path or drive) are not scanned. 

Add 

With this button, you can add the file object entered in the input box to the display 
window. 

Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 
selected. 
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Heuristic 

This configuration section contains the settings for the heuristic of the scan 

engine. (Options available in expert mode only.) 

Avira products contain very powerful heuristics that can proactively uncover unknown 
malware, i.e. before a special virus signature to combat the damaging element has been 
created and before a virus guard update has been sent. Virus detection involves an 
extensive analysis and investigation of the affected codes for functions typical of malware. 
If the code being scanned exhibits these characteristic features, it is reported as being 
suspicious. This does not necessarily mean that the code is in fact malware. False 
positives do sometimes occur. The decision on how to handle affected code is to be made 
by the user, e.g. based on his or her knowledge of whether the source of the code is 

trustworthy or not. 

Macrovirus heuristic 

Macrovirus heuristic 

Your Avira product contains a highly powerful macrovirus heuristic. If this option is 
enabled, all macros in the relevant document are deleted in the event of a repair, 
alternatively suspect documents are only reported, i.e. you receive an alert. This 
option is enabled as the default setting and is recommended. 

Advanced Heuristic Analysis and Detection (AHeAD) 

Enable AHeAD 

Your Avira program contains a very powerful heuristic in the form of Avira AHeAD 
technology, which can also detect unknown (new) malware. If this option is enabled, 
you can define how "aggressive" this heuristic should be. This option is enabled as the 

default setting. 

Low detection level 

If this option is enabled, slightly less unknown malware is detected, the risk of false 
alerts is low in this case. 

Medium detection level 

This option combines a strong detection level with a low risk of false alerts. Medium is 
the default setting if you have selected the use of this heuristic. 

High detection level 

If this option is enabled, significantly more unknown malware is detected, but there are 
also likely to be false positives. 

10.1.2 Report 

The System Scanner has a comprehensive reporting function. You thus obtain precise 
information on the results of an on-demand scan. The report file contains all entries of the 
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system as well as alerts and messages of the on-demand scan. (Options available in 
expert mode only.) 

Note 
To be able to establish what actions the System Scanner has performed, when 
viruses or unwanted programs have been detected, you should activate the 
report file in the expert-mode configuration. 

Reporting 

Off 

If this option is enabled, the System Scanner does not report the actions and results of 

the on-demand scan. 

Default 

When this option is activated, the System Scanner logs the path and names of the 
concerning files. In addition, the configuration for the current scan, version information 

and information on the licensee is written in the report file. 

Extended 

When this option is activated, the System Scanner logs alerts and tips in addition to 

the default information.  

Complete 

When this option is activated, the System Scanner also logs all scanned files. In 

addition, all files involved as well as alerts and tips are included in the report file. 

Note 
If you have to send us a report file at any time (for troubleshooting), please 

create this report file in this mode. 

10.2 Real-Time Protection 

The Real-Time Protection section of the configuration is responsible for the configuration 

of the on-access scan. (Options available in expert mode only.) 

10.2.1 Scan 

You will normally want to monitor your system constantly. To this end, use the Real-Time 
Protection (= on-access System Scanner). You can thus scan all files that are copied or 
opened on the computer "on the fly", for viruses and unwanted programs. (Options 

available in expert mode only.) 
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Files 

The Real-Time Protection can use a filter to scan only those files with a certain extension 
(type). 

All files 

If this option is enabled, all files are scanned for viruses or unwanted programs, 

irrespective of their content and their file extension. 

Note 
If All files is enabled, the File extensions button cannot be selected. 

Use smart extensions 

If this option is enabled, the selection of the files scanned for viruses or unwanted 
programs is automatically chosen by the program. This means that the program 
decides whether the files are scanned or not based on their content. This procedure is 
somewhat slower than Use file extension list, but more secure, since not only on the 

basis of the file extension is scanned. 

Note 
If Use smart extensions is enabled, the File extensions button cannot be 

selected. 

Use file extension list 

If this option is enabled, only files with a specified extension are scanned. All file types 
that may contain viruses and unwanted programs are preset. The list can be edited 
manually via the "File extensions" button. This option is enabled as the default 

setting and is recommended. 

Note 
If this option is enabled and you have deleted all entries from the list with file 
extensions, this is indicated with the text "No file extensions" under the File 

extensions button. 

File extensions 

With the aid of this button, a dialog box is opened in which all file extensions are 
displayed that are scanned in "Use file extension list" mode. Default entries are set 

for the extensions, but entries can be added or deleted. 

Note 
Please note that the file extension list may vary from version to version. 
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Scan mode 

Here the time for scanning of a file is defined. 

Scan when reading 

If this option is enabled, the Real-Time Protection scans the files before they are read 

or executed by the application or the operating system. 

Scan when writing 

If this option is enabled, the Real-Time Protection scans a file when writing. You can 

only access the file again after this process has been completed. 

Scan when reading and writing 

If this option is enabled, the Real-Time Protection scans files before opening, reading 
and executing and after writing. This option is enabled as the default setting and is 

recommended. 

Archives 

Scan archives 

If this option is enabled, then archives will be scanned. Compressed files are scanned, 
then decompressed and scanned again. This option is deactivated by default. The 
archive scan is restricted by the recursion depth, the number of files to be scanned 
and the archive size. You can set the maximum recursion depth, the number of files to 

be scanned and the maximum archive size. 

Note 
This option is deactivated by default, since the process puts heavy demands on 
the computer's performance. It is generally recommended that archives be 

checked using an on-demand scan. 

Max. recursion depth 

When scanning archives, the Real-Time Protection uses a recursive scan: Archives in 
archives are also unpacked and scanned for viruses and unwanted programs. You can 
define the recursion depth. The default value for the recursion depth is 1 and is 

recommended: all files that are directly located in the main archive are scanned. 

Max. number of files 

When scanning archives, you can restrict the scan to a maximum number of files in 
the archive. The default value for the maximum number of files to be scanned is 10 
and is recommended. 

Max. size (KB) 

When scanning archives, you can restrict the scan to a maximum archive size to be 
unpacked. The standard value of 1000 KB is recommended. 
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Action on detection 

Use event log 

If this option is enabled, an entry is added to the Windows event log for every 
detection. The events can be called up in the Windows event viewer. This option is 

enabled as the default setting. (Option available in expert mode only.) 

Exceptions 

With these options you can configure exception objects for the Real-Time Protection (on-
access scan). The relevant objects are then not included in the on-access scan. The Real-
Time Protection can ignore file accesses to these objects during the on-access scan via 
the list of processes to be omitted. This is useful, for example, with databases or backup 

solutions. (Options available in expert mode only.) 

Please note the following when specifying processes and file objects to be omitted: The list 
is processed from top to bottom. The longer the list is, the more processor time is required 

for processing the list for each access. Therefore, keep the list as short as possible. 

Processes to be omitted by the Real-Time Protection 

All file accesses of processes in this list are excluded from monitoring by Real-Time 
Protection. 

Input box 

In this field, enter the name of the process that is to be ignored by the real-time scan. 
No process is entered as the default setting. 

The specified path and file name of the process should contain a maximum of 255 
characters. You can enter up to 128 processes. The entries in the list must not result 

in more than 6000 characters in total. 

When entering the process, Unicode symbols are accepted. You can therefore enter 
process or directory names containing special symbols. 

Drive information must be entered as follows: [Drive letter]:\ 

The colon symbol (:) is only used to specify drives. 

When specifying the process, you can use the wildcards * (any number of characters) 
and ? (a single character). 

C:\Program Files\Application\application.exe 

C:\Program Files\Application\applicatio?.exe 

C:\Program Files\Application\applic*.exe 

C:\Program Files\Application\*.exe 

To avoid the process being excluded globally from monitoring by Real-Time 
Protection, specifications exclusively comprising the following characters are invalid: * 

(asterisk), ? (question mark), / (forward slash), \ (backslash), . (dot), : (colon). 
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You have the option of excluding processes from monitoring by the Real-Time 

Protection without full path details. For example: application.exe 

This however only applies to processes where the executable files are located on hard 
disk drives. 

Do not specify any exceptions for processes where the executable files are located on 
dynamic drives. Dynamic drives are used for removable disks, such as CDs, DVDs or 

USB sticks. 

Warning 
Please note that all file accesses done by processes recorded in the list are 

excluded from the scan for viruses and unwanted programs!  

 

The button opens a window in which you can select an executable file. 

Processes 

The "Processes" button opens the "Process selection" window in which the running 

processes are displayed. 

Add 

With this button, you can add the process entered in the input box to the display 

window. 

Delete 

With this button you can delete a selected process from the display window. 

File objects to be omitted by the Real-Time Protection 

All file accesses to objects in this list are excluded from monitoring by the Real-Time 
Protection. 

Input box 

In this box you can enter the name of the file object that is not included in the on-

access scan. No file object is entered as the default setting. 

The entries in the list must have no more than 6000 characters in total. 

When specifying file objects to be omitted, you can use the wildcards* (any number of 
characters) and ?? (a single character): Individual file extensions can also be excluded 

(including wildcards): 

C:\Directory\*.mdb 

*.mdb 

*.md? 
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*.xls* 

C:\Directory\*.log 

Directory names must end with a backslash \ . 

If a directory is excluded, all its sub-directories are automatically also excluded. 

For each drive you can specify a maximum of 20 exceptions by entering the complete 

path (starting with the drive letter). For example: 

C:\Program Files\Application\Name.log 

The maximum number of exceptions without a complete path is 64. For example: 

*.log  

In case of dynamic drives that are mounted as a directory on another drive, the alias of 

the operating system for the integrated drive in the list of the exceptions has to be 
used, e.g.: 

\Device\HarddiskDmVolumes\PhysicalDmVolumes\BlockVolume1\ 

If you use the mount point itself, for example, C:\DynDrive, the dynamic drive will be 

scanned nonetheless. You can determine the alias of the operating system to be used 

from the Real-Time Protection report file. 

 

The button opens a window in which you can select the file object to be excluded. 

Add 

With this button, you can add the file object entered in the input box to the display 

window. 

Delete 

With this button you can delete a selected file object from the display window. 

Please note the further information when specifying exceptions: 

In order to also exclude objects when they are accessed with short DOS file names (DOS 

name convention 8.3), the relevant short file name must also be entered in the list. 

A file name that contains wildcards may not be terminated with a backslash. For example: 
C:\Program Files\Application\applic*.exe\ 

This entry is not valid and not treated as an exception! 

You can locate the path Real-Time Protection uses to scan for infected files in the Real-
Time Protection report file. Indicate exactly the same path in the list of exceptions. 
Proceed as follows: Set the protocol function of the Real-Time Protection to Complete in 
the configuration under Real-Time Protection > Report. Now access the files, folders, 
mounted drives with the activated Real-Time Protection. You can now read the path to be 
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used from the Real-Time Protection report file. The report file can be accessed in the 
Control Center under Local protection > Real-Time Protection. 

Heuristic 

This configuration section contains the settings for the heuristic of the scan 

engine. (Options available in expert mode only.) 

Avira products contain very powerful heuristics that can proactively uncover unknown 
malware, i.e. before a special virus signature to combat the damaging element has been 
created and before a virus guard update has been sent. Virus detection involves an 
extensive analysis and investigation of the affected codes for functions typical of malware. 
If the code being scanned exhibits these characteristic features, it is reported as being 
suspicious. This does not necessarily mean that the code is in fact malware. False 
positives do sometimes occur. The decision on how to handle affected code is to be made 
by the user, e.g. based on his or her knowledge of whether the source of the code is 

trustworthy or not. 

Macrovirus heuristics 

Macrovirus heuristics 

Your Avira product contains a highly powerful macrovirus heuristic. If this option is 
enabled, all macros in the relevant document are deleted in the event of a repair, 
alternatively suspect documents are only reported, i.e. you receive an alert. This 
option is enabled as the default setting and is recommended. 

Advanced Heuristic Analysis and Detection (AHeAD) 

Enable AHeAD 

Your Avira program contains a very powerful heuristic in the form of Avira AHeAD 
technology, which can also detect unknown (new) malware. If this option is enabled, 
you can define how "aggressive" this heuristic should be. This option is enabled as the 

default setting. 

Low detection level 

If this option is enabled, slightly less unknown malware is detected, the risk of false 
alerts is low in this case. 

Medium detection level 

This option combines a strong detection level with a low risk of false alerts. Medium is 
the default setting if you have selected the use of this heuristic. 

High detection level 

If this option is enabled, significantly more unknown malware is detected, but there are 
also likely to be false positives. 
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10.2.2 Report 

Real-Time Protection includes an extensive logging function to provide the user or 
administrator with exact notes about the type and manner of a detection. (Options 
available in expert mode only.) 

Reporting 

This group allows for the content of the report file to be determined. 

Off 

If this option is enabled, then Real-Time Protection does not create a log. 
It is recommended that you should turn off the logging function only in exceptional 

cases, such as if you are executing trials with multiple viruses or unwanted programs. 

Default 

If this option is enabled, Real-Time Protection records important information 
(concerning detections, alerts and errors) in the report file, with less important 
information ignored for improved clarity. This option is enabled as the default setting. 

Extended 

If this option is enabled, Real-Time Protection logs less important information to the 
report file as well. 

Complete 

If this option is enabled, Real-Time Protection logs all available information in the 
report file, including file size, file type, date, etc. 

Limit report file 

Limit size to n MB 

If this option is enabled, the report file can be limited to a certain size. Permitted values 
are between 1 and 100 MB. Around 50 kilobytes of extra space are allowed when 
limiting the size of the report file to minimize the use of system resources. If the size of 
the log file exceeds the indicated size by more than 50 kilobytes, then old entries are 

deleted until the indicated size minus 50 kilobytes is reached. 

Back up report file before shortening 

If this option is enabled, the report file is backed up before shortening. 

Write configuration to report file 

If this option is enabled, the configuration of the on-access scan is recorded in the 

report file. 
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Note 
If you have not specified any report file restriction, a new report file is 
automatically created when the report file reaches 100MB. A backup of the old 
report file is created. Up to three backups of old report files are saved. The 

oldest backups are deleted first. 

10.3 Update 

In the Update section you can configure the automatic receiving of updates. You can 

specify various update intervals. 

Automatic update 

All n Day(s) / Hour(s) / Minute(s) 

In this box you can specify the interval at which the automatic update is performed. To 
change the update interval, highlight one of the time options in the box and change it 

using the arrow key to the right of the input box. 

Repeat job if the time has already expired 

If this option is enabled, past update jobs are performed that could not be performed at 
the time specified, for example because the computer was switched off. (Option 

available in expert mode only.) 

10.3.1 Product update 

Under Product update, configure how product updates or the notification of available 

product updates are handled. (Options available in expert mode only.) 

Product updates 

Download and install product updates automatically 

If this option is enabled, product updates are downloaded and automatically installed 
by the Update component as soon as they become available. Updates to the virus 
definition file and scan engine are performed independently of this setting. The 
conditions for this option are: complete configuration of the update and an open 
connection to a download server. 

Download product updates. If a restart is necessary, install the update after the 
system restart, otherwise install it immediately 

If this option is enabled, product updates will be downloaded as soon as they become 
available. If no restart is necessary, the update is installed automatically after the 
update file is downloaded. If a product update requires you to restart your computer, it 
will be executed at the next user-controlled system reboot and not immediately after 
the download of the update file. This has the advantage that the restart is not 
performed while users are working at their computers. Updates to the virus definition 
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file and scan engine are performed independently of this setting. The conditions for 
this option are: complete configuration of the update and an open connection to a 

download server. 

Notify user if product updates are available 

If this option is enabled, you will only be notified when new product updates become 
available. Updates to the virus definition file and scan engine are performed 
independently of this setting. The conditions for this option are: complete configuration 
of the update and an open connection to a download server. You will receive 
notifications via a desktop popup window and via an alert from the Updater in the 

Control Center under Overview > Events.  

Notify once again after n day(s) 

If the product update was not installed after the initial notification, enter in this box the 
number of days that are to elapse before you are again notified that product updates 
are available. 

Do not download product updates 

If this option is enabled, no automatic product updates or notifications of available 
product updates by the Updater are performed. Updates to the virus definition file and 

search engine are performed independently of this setting. 

Warning 
An update of the virus definition file and of the search engine is performed 
during every update process independent of the settings for the product update 

(see Chapter Updates). 

Note 
If you have enabled an option for an automatic product update, you can 
configure further restart notification and cancellation options under Restart 
settings. (Options available in expert mode only.) 

10.3.2 Restart settings 

When a product update for your Avira product is performed, you may have to restart your 
computer system. If you have selected automatic product updates under Local protection > 

Update > Product update, you can choose between the different restart notification and 
restart cancellation options under Restart settings. (Options available in expert mode 

only.) 

Note 
Note that your restart settings allow you to choose between two options for 
executing a product update requiring a computer restart in the configuration 
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under Local protection > Update > Product update. 
Download and install product updates automatically: The update and the 
restart are performed while users are working on their computers. If you have 
enabled this option, it may be useful to select restart routines with a cancel 
option or reminder function. 
Download product updates. If a restart is necessary, install the update 
after the system restart, otherwise install it immediately: the update and the 
restart are performed after users have started up their computers and logged in. 

Automatic restart routines are recommended for this option. 

Restart the computer after n Seconds (with countdown messages, cannot be 
canceled) 

If this option is enabled, the restart which is necessary after a product update has 
been executed is performed automatically at the specified interval. A countdown 

message appears with no option for canceling the computer restart. 

Periodic restart reminder 

If this option is enabled, the restart which is necessary after a product update has 
been executed is not performed automatically. At the specified interval, you will 
receive restart notifications without cancel options. These notifications let you confirm 
the computer restart or select another time for the reminder. 

Query whether computer should be restarted 

If this option is enabled, the restart which is necessary after a product update has 
been executed is not performed automatically. You will receive only one message, 

which offers the option to perform a restart directly or cancel the restart routine. 

Restart computer without query 

If this option is enabled, the restart which is necessary after a product update has 

been executed is performed automatically. You will not receive any notification. 

10.3.3 Web server 

Web server 

The update can be performed directly via a web server on the Internet. (Options available 

in expert mode only.) 

Web server connection 

Use existing connection (network) 

This setting is displayed if your connection is used via a network. 

Use the following connection 

This setting is displayed if you define your connection individually. 
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The Updater automatically detects which connection options are available. Connection 
options that are not available are grayed out and cannot be activated. A dial-up 
connection can be established manually via a phone book entry in Windows, for 

example. 

User 

Enter the user name of the selected account. 

Password 

Enter the password for this account. For security reasons, the actual characters you 
type in this space are replaced by asterisks (*). 

Note 

If you have forgotten an existing Internet account name or password, contact 
your Internet Service Provider. 

  

Note 
The automatic dial-up of the updater through so-called dial-up tools (e.g. 

SmartSurfer, Oleco, etc.) is currently not yet available. 

Terminate a dial-up connection that was set up for the update 

If this option is enabled, the dial-up connection made for the update is automatically 
interrupted again as soon as the download has been successfully performed. 

Note 
This option is not available under Vista and Windows 7. Under these operating 
systems the dial-up connection opened for the update is always terminated as 
soon as the download has been performed. 

Proxy settings 

Proxy server 

Do not use a proxy server 

If this option is enabled, your connection to the web server is not established via a 

proxy server. 

Use proxy system settings 

When the option is enabled, the current Windows system settings are used for the 
connection to the web server via a proxy server. Configure the Windows system 
settings to use a proxy server under Control panel > Internet options > 
Connections > LAN settings. You can also access the Internet options in the Extras 

menu in Internet Explorer. 
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Warning 
If you are using a proxy server which requires authentication, enter all the 
required data under the option Use this proxy server. The Use proxy system 
settings option can only be used for proxy servers without authentication. 

Use this proxy server 

If your web server connection is set up via a proxy server, you can enter the relevant 

information here. 

Address 

Enter the computer name or IP address of the proxy server you want to use to connect 
to the web server. 

Port 

Please enter the port number of the proxy server you want to use to connect to the 
web server. 

Login name 

Enter a user name to log in on the proxy server. 

Login password 

Enter the relevant password for logging in on the proxy server here. For security 
reasons, the actual characters you type in this space are replaced by asterisks (*). 

Examples: 

Address: proxy.domain.com Port: 8080 

Address: 192.168.1.100 Port: 3128 

10.4 Web Protection 

The Web Protection section under Configuration > Internet Protection is responsible 

for the configuration of the Web Protection.  

10.4.1 Scan 

Web Protection protects you against viruses or malware that reach your computer from 
web pages that you load on your web browser from the Internet. The Scan options can be 
used to set the behavior of the Web Protection component. (Options available in expert 

mode only.) 

Scan 

Enable IPv6 support 

If this option is enabled, Internet Protocol version 6 is supported by the Web 

Protection. 
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Drive-by protection 

Drive-by protection allows you to make settings to block I-Frames, also known as inline 
frames. I-Frames are HTML elements, i.e. elements of Internet pages that delimit an area 
of a web page. I-Frames can be used to load and display different web content - usually 
other URLs - as independent documents in a sub-window of the browser. I-Frames are 
mostly used for banner advertising. In some cases, I-Frames are used to conceal 
malware. In these cases the area of the I-Frame is mostly invisible or almost invisible in 
the browser. The Block suspicious I-frames option allows you to check and block the 

loading of I-Frames. 

Block suspicious I-frames 

If this option is enabled, I-Frames on the web pages you request are scanned 

according to certain criteria. If there are suspect I-Frames on a requested web page, 
the I-Frame is blocked. An error message is displayed in the I-Frame window. 

Action on detection 

You can define the actions to be performed by Web Protection when a virus or unwanted 

program is detected. (Options available in expert mode only.) 

Interactive 

If this option is enabled, a dialog box appears when a virus or unwanted program is 
detected during an on-demand scan, in which you can choose what is to be done with 

the affected file. This option is enabled as the default setting. 

Show progress bar 

If this option is enabled, a desktop notification appears with a download progress bar if 
a download of website content exceeds a 20 second timeout. This desktop notification 
is designed in particular for downloading websites with larger data volumes: If you are 
surfing with Web Protection, website contents are not downloaded incrementally in the 
Internet browser, as they are scanned for viruses and malware before being displayed 
in the Internet browser. This option is disabled as the default setting. 

Click here for more information. 

Automatic 

If this option is enabled, no dialog box in case of a virus detection appears. Web 
Protection reacts according to the settings you predefine in this section as primary and 

secondary action. 

Primary action 

The primary action is the action performed when Web Protection finds a virus or an 

unwanted program. 

Deny access 

The website requested from the web server and/ or any data or files transferred are 
not sent to your web browser. An error message to notify you that access has been 
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denied is displayed in the web browser. Web Protection logs the detection to the report 
file if the report function is activated. 

Move to quarantine 

In the event of a virus or malware being detected, the website requested from the web 
server and/ or the transferred data and files are moved into quarantine. The affected 
file can be recovered from the quarantine manager if it has any informative value or - if 

necessary - sent to the Avira Malware Research Center. 

Ignore 

The website requested from the web server and/ or the data and files that were 
transferred are forwarded on by Web Protection to your web browser. Access to the 
file is permitted and the file is ignored. 

Warning 
The affected file remains active on your workstation! It may cause serious 

damage on your workstation! 

Blocked requests 

In Blocked requests you can specify the file types and MIME types (content types for the 
transferred data) to be blocked by Web Protection. Web Protection prevents the transfer of 
data from the Internet to your computer system. (Options available in expert mode only.) 

Web Protection blocks the following file types / MIME-Types 

All file types and MIME types (content types for the transferred data) in the list are blocked 
by Web Protection. 

Input box 

In this box, enter the names of the MIME types and file types you want Web Protection 
to block. For file types, enter the file extension, e.g. .htm. For MIME types, indicate the 
media type and, where applicable, sub-type. The two statements are separated from 

one another by a single slash, e.g. video/mpeg or audio/x-wav. 

Note 
Files which are already stored on your system as temporary Internet files and 
blocked by Web Protection can, however, be downloaded locally from the 
Internet by your computer's Internet browser. Temporary Internet files are files 
saved on your computer by the Internet browser so that websites can be 
accessed more quickly. 
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Note 
The list of blocked file and MIME types is ignored if they are entered in the list of 

excluded file and MIME types under Web Protection > Scan > Exceptions. 

  

Note 
No wildcards (* for any number of characters or ?  for a single character) can be 
used when entering file types and MIME types. 

MIME types: Examples for media types:  

 text = for text files 

 image = for graphics files 

 video = for video files 

 audio = for sound files 

 application = for files linked to a particular program 

Examples of excluded file and MIME types  

 application/octet-stream = application/octet-stream MIME type files 

(executable files *.bin, *.exe, *.com, *dll, *.class) are blocked by Web Protection. 

 application/olescript = application/olescript MIME type files (ActiveX script-

files *.axs) are blocked by Web Protection. 

 .exe = All files with the extension .exe (executable files) are blocked by Web 

Protection. 

 .msi = All files with the extension .msi (Windows Installer files) are blocked by Web 

Protection. 

Add 

The button allows you to copy MIME and file types from the input field into the display 
window. 

Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 
selected. 

Exceptions 

These options allow you to set exceptions based on MIME types (content types for the 
transferred data) and file types for URLs (Internet addresses) for scanning by Web 
Protection. The MIME types and URLs specified are ignored by Web Protection, i.e. that 
data is not scanned for viruses and malware when it is transferred to your computer 

system. (Options available in expert mode only.) 
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MIME types skipped by Web Protection 

In this field you can select the MIME types (content types for the transferred data) to be 
ignored by Web Protection during scanning. 

File types/MIME types skipped by Web Protection (user-defined) 

All MIME types (content types for the transferred data) in the list are ignored by Web 
Protection during scanning. 

Input box 

In this box you can input the name of the MIME types and file types to be ignored by 
Web Protection during scanning. For file types, enter the file extension, e.g.  .htm. For 

MIME types, indicate the media type and, where applicable, sub-type. The two 
statements are separated from one another by a single slash, e.g.  video/mpeg or 

audio/x-wav. 

Note 
No wildcards (* for any number of characters or ?  for a single character) can be 
used when entering file types and MIME types. 

Warning 
All file types and content types on the exclusion list are downloaded into the 
Internet browser without further scanning of the blocked requests (List of file 
and MIME types to be blocked in Web Protection > Scan > Blocked requests) or 
by Web Protection: For all entries on the exclusion list, the entries on the list of 
file and MIME types to be blocked are ignored. No scan for viruses and 

malware is performed. 

MIME types: Examples for media types:  

 text = for text files 

 image = for graphics files 

 video = for video files 

 audio = for sound files 

 application = for files linked to a particular program 

Examples of excluded file and MIME types: 

 audio/ = All audio media type files are excluded from Web Protection scans 

 video/quicktime = All Quicktime sub-type video files (*.qt, *.mov) are excluded 

from Web Protection scans 

 .pdf = All Adobe PDF files are excluded from Web Protection scans.  
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Add 

The button allows you to copy MIME and file types from the input field into the display 
window. 

Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 
selected. 

URLs skipped by Web Protection 

All URLs in this list are excluded from Web Protection scans. 

Input box 

In this box you can input URLs (Internet addresses) to be excluded from Web 

Protection scans, e.g. www.domainname.com. You can specify parts of the URL, 

using leading or following dots to indicate the domain level: .domainname.com for all 

pages and all subdomains of the domain. Indicate websites with any top-level domain 

(.com or .net) with a following dot: domainname.. If you indicate a string without a 

leading or concluding dot, the string is interpreted as a top-level domain, e.g. net for 

all NET domains (www.domain.net). 

Note 
You can also use the wildcard * for any number of characters when specifying 
URLs. You can also use leading or following dots in combination with wildcards 
to indicate the domain level: 
.domainname.* 

*.domainname.com 

.*name*.com (valid but not recommended) 

Specifications without dots, like *name*, are interpreted as part of a top-level 

domain and are not advisable. 

Warning 
All websites on the list of excluded URLs are downloaded into the Internet 
browser without further scanning by Web Protection: No scan for viruses and 
malware is performed. Only trusted URLs should therefore be excluded from 

Web Protection scans. 

Add 

The button allows you to copy the URL entered in the input field (Internet address) to 
the viewer window. 
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Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 
selected. 

Examples: Skipped URLs 

 www.avira.com  -OR- www.avira.com/* 

= All URLs with the domain www.avira.com are excluded from Web Protection 

scans: www.avira.com/en/pages/index.php, www.avira.com/en/support/index.html, 
www.avira.com/en/download/index.html, etc. 

URLs with the domain www.avira.de are not excluded from Web Protection scans. 

 avira.com  -OR- *.avira.com 

= All URLs with the second and top-level domain avira.com are excluded from 

Web Protection scans: The specification implies all existing subdomains for 

.avira.com: www.avira.com, forum.avira.com, etc. 

 avira. -OR- *.avira.* 

= All URLs with the second-level domain avira are excluded from Web Protection 

scans: The specification implies all existing top-level domains or subdomains for 

.avira: www.avira.com, www.avira.de, forum.avira.com, etc. 

 .*domain*.* 

All URLs containing a second-level domain with the string domain are excluded from 

Web Protection scans: www.domain.com, www.new-domain.de, www.sample-

domain1.de, ... 

 net -OR- *.net 

= All URLs with the top-level domain net are excluded from Web Protection scans: 

www.name1.net, www.name2.net, etc. 

Warning 
Enter the URLs you want to exclude from the Web Protection scan as precisely 
as possible. Avoid specifying an entire top-level domain or parts of a second-
level domain because there is a risk that Internet pages that distribute malware 
and undesirable programs will be excluded from the Web Protection scan 
through global specifications under exclusions. You are recommended to 
specify at least the complete second-level domain and the top-level domain: 
domainname.com 

Heuristic 

This configuration section contains the settings for the heuristic of the scan 

engine. (Options available in expert mode only.) 

Avira products contain very powerful heuristics that can proactively uncover unknown 
malware, i.e. before a special virus signature to combat the damaging element has been 
created and before a virus guard update has been sent. Virus detection involves an 
extensive analysis and investigation of the affected codes for functions typical of malware. 
If the code being scanned exhibits these characteristic features, it is reported as being 
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suspicious. This does not necessarily mean that the code is in fact malware. False 
positives do sometimes occur. The decision on how to handle affected code is to be made 
by the user, e.g. based on his or her knowledge of whether the source of the code is 

trustworthy or not. 

Macrovirus heuristic 

Your Avira product contains a highly powerful macrovirus heuristic. If this option is 
enabled, all macros in the relevant document are deleted in the event of a repair, 
alternatively suspect documents are only reported, i.e. you receive an alert. This 

option is enabled as the default setting and is recommended. 

Advanced Heuristic Analysis and Detection (AHeAD) 

Enable AHeAD 

Your Avira program contains a very powerful heuristic in the form of Avira AHeAD 
technology, which can also detect unknown (new) malware. If this option is enabled, 
you can define how "aggressive" this heuristic should be. This option is enabled as the 

default setting. 

Low detection level 

If this option is enabled, slightly less unknown malware is detected, the risk of false 
alerts is low in this case. 

Medium detection level 

This option combines a strong detection level with a low risk of false alerts. Medium is 
the default setting if you have selected the use of this heuristic. 

High detection level 

If this option is enabled, significantly more unknown malware is detected, but there are 
also likely to be false positives. 

10.4.2 Report 

The Web Protection includes an extensive logging function to provide the user or 

administrator with exact notes about the type and manner of a detection. 

Reporting 

This group allows for the content of the report file to be determined. 

Off 

If this option is enabled, then Web Protection does not create a log. 
It is recommended that you should turn off the logging function only in exceptional 
cases, such as if you are executing trials with multiple viruses or unwanted programs. 
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Default 

If this option is enabled, Web Protection records important information (concerning 
detections, alerts and errors) in the report file, with less important information ignored 

for improved clarity. This option is enabled as the default setting. 

Advanced 

If this option is enabled, Web Protection logs less important information to the report 

file as well. 

Complete 

If this option is enabled, Web Protection logs all available information in the report file, 

including file size, file type, date, etc. 

Limit report file 

Limit size to n MB 

If this option is enabled, the report file can be limited to a certain size; possible values: 
Permitted values are between 1 and 100 MB. Around 50 kilobytes of extra space are 
allowed when limiting the size of the report file to minimize the use of system 
resources. If the size of the log file exceeds the indicated size by more than 50 
kilobytes, old entries are then deleted until the indicated size has been reduced by 

20%. 

Write configuration in report file 

If this option is enabled, the configuration of the on-access scan is recorded in the 

report file. 

Note 
If you have not specified any report file restriction, older entries are 
automatically deleted when the report file reaches 100MB. Entries are deleted 

until the size of the report file reaches 80 MB. 

10.5 Child Protection 

Use Avira's CHILD PROTECTION features, to ensure a safe Internet experience for your 

children or other persons using your computer. 

 With the Social Networks feature, you can monitor your children's activities online. The 
Social Networks technology checks their social network accounts for comments, photos 
etc. that may influence your child's reputation in a negative way or may indicate that 
your child is in danger. 

Related topics: 

 Social Networks 
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10.5.1 Social Networks 

This chapter contains comprehensive information on 

Creating a Social Network Protection account 
Logging into your Social Network Protection account  

Creating a Social Network Protection account 

  Make sure that your computer is connected to the internet. 

 Click Control Center > View > Child Protection > Social Networks. 

 Click Get Started Now. 

  The web browser opens displaying the Avira Social Network Protection website. 

  If you have a Facebook account, you can now log in to Avira Social Network 
Protection by clicking the Facebook logo. 

-OR- 

  If you do not have a Facebook account, enter your first name, your last name, your 
email address and a password in the required fields and click Get Started. 

Note 

From now on your email address will serve as your username. 

Logging in to an existing Social Network Protection account 

  Make sure that your computer is connected to the internet. 

  Click Control Center > View > Child Protection > Social Networks. 

 Click Log in. 

  If you have saved the cookie on your system, the web browser opens displaying 
your Avira Social Network Protection dashboard. 

-OR- 

  If your web browser does not accept cookies or removes them every time your 
web browser is closed, you can either log in by clicking on the Facebook logo or 
by entering your username and password. 

10.6 Mobile Protection 

Avira does not only protect your computer system from malware and viruses but also 
protects your smartphone, running with Android operating system, from loss and theft. 
Using Avira Free Android Security you can also block unwanted calls or SMS. Simply add 
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phone numbers from call log, SMS log and your list of contacts to the blacklist, or create 
manually a contact you want to block. 

10.6.1 Android Security 

Avira Free Android Security 

Avira Free Android Security consists of two components: 

 The app itself, installed on your Android device 

 The Avira Android Web Console for registration and feature control 

System Requirements 

Operating system: 

 Android 2.2 (Froyo) 

 Android 2.3.x (Gingerbread) 

 Android 4.0.x (Ice Cream Sandwich) 

Memory: 

 1.72 MB free internal memory space. 

Browsers: 

 Mozilla Firefox 

 Google Chrome 

 Opera 

 Internet Explorer IE7 or higher. 

Note 
Please note that Java has to be installed, JavaScript has to be enabled and that 

working Internet connection is needed. 

Features 

In order to protect your privacy and to protect your personal data if you cannot find your 
device, Avira Free Android Security offers four features via the Avira Android Web 
Console: 

Remote Scream 

You prompt an alarm on your device that lasts 20 seconds. 
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Remote Location Tracking 

You activate a location command that gives back the location parameters of the 
device. 

Remote Lock 

You may lock your device immediately using a 4 digit PIN. 

Remote Wipe 

You may remove data from the SIM card or internal and external memory cards. You 

may also perform a factory reset of your device via the Web Console. 

Note 
For triggering a Factory Reset command to delete all data from your device in 
case of loss or theft, you have to activate the function Device administrator 

during setup. 

In order to block certain phone numbers, Avira Free Android Security offers a so-called 
blacklist feature on your device. 

Blacklist 

You may add contacts to the blacklist from call log, SMS log and your list of contacts, 

or you may create manually a contact you want to block. 

The Web Console 

The Avira Android Web Console is a browser based control center designed for managing 
the security functions. You will use the Dashboard of the Web Console for handling your 
account and for triggering remote features such as Locate Device, Lock, Trigger Scream 

or Wipe. 

The Avira Android Web Console consists of a title bar, a side bar and the main screen with 
several tabs. The title bar displays your login credentials and contains links to the Support 
section and to your Account Management. On the side bar your registered devices are 
listed. On the main screen of the Web Console you find all security features for the app as 

well as information about the Blacklist feature on your device. 

Installation and Uninstallation 

Installation and Uninstallation of Avira Free Android Security 

Download and Installation 

Download the Avira Free Android Security app directly from Google Play to your device 
and install the app. After successful installation, the new features of the app are introduced 
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to you. Afterwards you are asked to register your device on the Avira Free Android 
Security Registration Screen. To do so, you may use your Google account or an email 
address by a different provider. You need a stable Internet connection for the registration 

process. 

 

  Tap OK on your device to open the registration form. 

  Enter your Google account or a different email address. 

  Tap Accept EULA and Continue to proceed. 

  Avira will send you a confirmation email for your new Avira Free Android Security 
account to the email address you have set. This confirmation email includes a 
link enabling you to set your personal password for the log in to the Android Web 
Console. 

  Click the link inside the confirmation email to set a password and to activate the 
Android Web Console. 

  You can now control remotely your devices using the Web Console. 

In order to allow Avira Free Android Security to wipe all data with a Factory Reset 
command from your device – for example in case of loss or theft – you have to activate the 

function Device administrator during setup: 
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  To activate the function Device administrator, tap the button Enable. 

  The dialog Activate device administrator will open. 

  Confirm the activation of Device administrator by tapping the button Activate. 

  This way you are allowing Avira Free Android Security  to erase all data from the 
device should you ever want to execute a Factory Reset command. 

In the case you are unsure about installing the function Device administrator during 
setup, you can always activate this configuration option at a later date. Please perform the 

following steps: 

  Open Avira Free Android Security on your device. 
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  Tap the button Settings. 

  You can now see that the option to erase all data by a Factory Reset command 
is disabled. 

  Tap the field Wipe settings. 

  The Wipe with factory reset dialog will open. You are asked to activate Device 
administrator. 

  Tap the button Enable at the bottom of the dialog. 

  Confirm the activation of the Device administrator by tapping Activate. 

  You are now informed that the Wipe with factory reset is enabled. 

Note 
You may enable or disable the function Device administrator at any time via 
the Avira Free Android Security application on your device, by choosing 

Settings > Wipe settings > Wipe with factory reset > Enable / Disable. 

Installation via PC 

You may download Avira Free Android Security app via PC. 

  Open Google Play on your PC. 

  Search for the  Avira Free Android Security app. 

  Click Install to download the application to your PC. 
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  You are asked to sign-in to install the app. 

  Click Sign In to get access to your Google account. 

  Type in your login credentials 

  Click OK to download the application to a selected device. 

  Avira Free Android Security app will be downloaded to this device. 

  Click OK to close the download dialog. 

  The Google Play website opens again and the Installed button displays that the 
application is already downloaded to your device. 

Uninstallation 

To uninstall Avira Free Android Security, two steps should be performed. You have to 
uninstall the application from your device and you have to delete the device from your 
Avira Android Web Console account. 

Note 
Please make sure that you have deactivated the function Device administrator 

on the device before you uninstall Avira Free Android Security. 

If you want to uninstall Avira Free Android Security, use the uninstall wizard of Avira Free 
Android Security or go to the Application Management of your device. 

If you use the uninstallation wizard, navigate from the Help button to the Go to 
uninstallation button. 

  Tap Help > Uninstall > Go to uninstallation. 

  The status information screen about device administrator opens. 

  Tap Device Administrator to deactivate the feature, if necessary. 

  Tap Continue to proceed with uninstall process. 

  The uninstallation survey screen opens. 

  Please select all answers that apply to you. 

  You can write a more detailed comment in the comment field. 

  Tap Continue to proceed with uninstallation. 

  Tap OK to finish the uninstall process. 

If you want to uninstall the app via the Application Management of your device, navigate 
from the Settings button of your device to the Manage applications function. 

  Tap the Avira Free Android Security app and choose Uninstall. 

  Confirm the uninstall process. 
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Furthermore you have to delete the device from the Avira Free Android Security Account 
of the Web Console. 

  Open the Avira Web Console. 

  Click the link Account in the title bar. 

  Go to the Device Management and open the drop down menu Available devices. 

  Select the device from which you want to delete the Avira Free Android Security App. 

  Click Delete device to remove the device from your account. 

Renewed Installation 

After uninstalling all your devices you are no longer able to access the Avira Web Console. 

You may install Avira Free Android Security again on your device by using your previous 
email account. 

  Enter the Web Console with your former login credentials. 

  You may change your password after login by navigating to the Password 
Management. 

Choose Account > Password Management, type your new password and confirm 
it. 

  If you cannot remember your password, click the link Forgot your password? at 
login. 

  You are asked to send us your email address and we will send you a recover link 
so that you can set your password again. 

Creating an Android account 

To keep an eye on your device and to protect your personal data by remote controls from 
the Web Console, you have to create an Avira Free Android Security account. 

  Open the Control Center of your Avira product. 

  Click Control Center > Mobile Protection > Avira Free Android Security. 

  The Avira Free Android Security download page opens. 
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  Click Download Now. 

  The Google Play Android Apps page opens. 

 Click Install. 

  You are asked to sign in to download Avira Free Android Security app. 

 Click Sign in to Google. 

 Enter your email address and your password. 

 Click Sign in. 

 Select the device to which Avira Free Android Security will be downloaded. 

 Click Install. 

  The application is downloaded to your device. 

  Open Avira Free Android Security on your device. 

  The new features of the app are introduced to you. Afterwards you are asked to 
register your device on the Avira Free Android Security Registration Screen. To 
do so, you may use your Google account or an email address by a different 
provider. 

  The Your Account screen opens. 
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  Enter your login credentials. 

  Tap Accept EULA and Continue to proceed. 

  Avira will send you a confirmation email for your new account. This information 
email includes a link to enabling you to set your personal password for the log in 
to Avira Free Android Security Web Console. 

  Click the link inside the confirmation email to set a password and to activate the 
account. 

  You can now control your devices using the Avira Free Android Security Web 
Console: https://android.avira.com 

Logging in to your Android account 

  Click Control Center > Mobile Protection > Avira Free Android Security. 

  The Avira Free Android Security download page opens. 

  Click Log in. 

  The Avira Free Android Security Login page opens. 

  Enter your registered email address and your password. 

  Click Log in to open the Web Console with its control functions. 

Handling 

The Web Console 

After successful installation you have to register your device to access the Avira Web 
Console. 

 The Avira Web Console consists of a title bar, a side bar and the main screen with 
several tabs. 

 The title bar displays your login credentials and contains links to the Support section 
and to your Account management. Furthermore, you may select the language settings 
for the Avira Web Console here. 

 On the side bar your registered devices are listed. 

 Each registered device is displayed on a single field: 

  Click the Edit button on the device’s field to be forwarded straight to the Settings tab 
of the Web Console where you can manage the name and the telephone number of 
your device. 

 At the bottom of the side bar you find a link to specify and save a personal security 
question. 

 On the main screen of the Web Console you find all security features to control your 
device as well as information about your blacklist content. 

https://android.avira.com/
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The Tabs of the Web Console screen 

The Web Console screen has the following tabs: 

 Dashboard 

 Locate Device 

 Wipe 

 Scream 

 Lock 

 Blacklist 

 Settings 

The Dashboard of Avira Free Android Security Web Console 

The Dashboard tab contains different information about your device as well as control 

buttons for triggering actions to secure your device. 

 

Device information 

 Brand: The brand of your device. 

 Model: The model identity of your device. 
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 IMEI: The International Mobile Equipment Identity is a unique 15-place number to 
identify mobile phones as well as some satellite phones. 

 OS version: The version number of your Android Operating System. 

 App Version: The version number of the Avira app currently installed. A red warning 
symbol is displayed if the version you are using is not up-to-date. 

 Dev. Admin.: Shows whether the device administrator is currently enabled. A red 
warning symbol is displayed if the function is not enabled. 

 Battery: Information of the charging level of the battery in percent. 

 Phone no: The phone number stored on the SIM card. 

 Network: The mobile network the SIM card belongs to. 

 Country: The home country of the SIM card. 

 Refresh: The refresh button to update the device information. 

Location tracking 

 

 Last located: The time when a device was last tracked, e.g. "5 hours ago", "3 days ago". 

 Latitude: The exact latitude of the device’s location. 

 Longitude: The exact longitude of the device’s location. 

Lock device 

 

 Last action: The last action that was taken via the Web Console, e.g. "Lock". 

 Last trigger: The time when a device was last locked / unlocked. 

Trigger scream 
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 Last triggered: The time when an alarm was last sent to a device. 

Wipe data 

 

 Last wipe: The time when a device was last wiped. 

 Type: The type of wipe action performed on the device. 

Blacklist 

 

 Use this feature to block unwanted calls and SMS. 

Locate Device 

The Locate Device tab displays an extract of Google Maps. Beneath the map the Location 
tracking status is shown. 
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  Click the button Locate your device to start a location tracking for the lost device. 

  The tracking may take several minutes depending on network performances and 
signal strength of the device. 

Avira Free Android Security searches the device via GPS, cell tower technology and 
wireless LAN. 

The elapsed tracking time is shown during the locating process. 

  As a result, the location of your lost device is pinpointed on a map. You can 
zoom in and out on the map. 

Wipe 

Note 
If the version of Avira Free Android Security your are using does not support the 
Wipe feature, please update the app on your device as described by our 
Knowledgebase. Afterwards you only need to refresh this page to access the 

full functionality of the Wipe feature. 

On the Wipe tab you find three options to delete data from your device. You also have the 
possibility to select a combination of these Wipe options. The Wipe function leads to a 
permanent data erasure, i.e. the data destroyed by the wipe procedure cannot be 

recovered. 

http://www.avira.com/en/support-for-home-knowledgebase-detail/kbid/1224
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Note 
It is strongly recommended to lock your device in order to trigger a wipe 
command. Please backup important data regularly. When there is a need to 
wipe the device, there is no opportunity to backup data at that moment. 

SIM card 

Triggering a SIM Card Wipe will delete all data of your SIM card. All contact data and 
SMS stored on the SIM card will be removed. Once deleted, this data cannot be 

recovered. Wiping the SIM card will not affect data stored on your device or SD card. 

 

Note 
Depending on the card type, a SIM Card Wipe may not always be possible. 

  Click Wipe SIM Card to delete all data stored on the SIM card. 

  Confirm the wipe by clicking OK. 

  The message Your SIM card was successfully wiped! is displayed. 

  Click OK to close the message and to return to the Wipe tab. 

All Storage 

Triggering a All Storage Wipe will delete all data stored on your SD card and in the 
internal USB storage. Once deleted, this data cannot be recovered. The All Storage Wipe 
function will not affect data stored on the SIM card. 

 

  Click Wipe Storages to trigger the delete of data stored directly on your device and 
SD card. 

  Confirm the wipe by clicking OK. 

  The message Your Storage was successfully wiped! is displayed. 

  Click OK to close the message and to return to the Wipe tab. 

Factory Reset 
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A Factory Reset will reset your device settings to their default state and also delete all 
accounts, applications and application data stored on the device. A Factory Reset will not 

affect data stored on the SIM card or SD card. 

 

Note 
To trigger a Factory Reset command to delete all data from your device in case 
of loss or theft, you have to activate the function Device administrator during 

setup. 

  Click Factory Reset to reset your device settings to their default state. 

  Confirm this kind of wipe by clicking OK. 

  Click OK again to continue. 

  To close the message informing you of the successful Factory Reset, click OK. 

Warning 
A Factory Reset will also uninstall Avira Free Android Security. You will no 
longer be able to send any commands to your device via the Web Console, i.e. 
you will not be able to lock or locate your device. 

Combo Wipe 

With a Combo Wipe you are able to trigger one, two or all three wipe types at the same 
time. 

  Select the wipe types you would like to trigger or click Select all to trigger a 
combination of all wipe type at once. 

  Click Wipe selected. 

  Confirm your choice by clicking OK. 

  Depending on your selection and device memory size this action may take up to 
60 minutes. 

  Click OK to continue. 

  To close the message, informing you of the successful Combo Wipe, click OK. 

The result of the three Wipe commands are the following: 
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Affected storage SIM Card Wipe All Storage Wipe Factory Reset 

SMS on device     deleted 

SMS on SIM deleted     

Contacts on device     deleted 

Contacts on SIM deleted     

SD card contents   deleted   

Internal USB 
storage contents 

  deleted   

Accounts, apps, 

app data 

    deleted 

 

Scream 

On the Scream tab you trigger a loud alarm emitted by your device. This function will help 
you to quickly find your device. 

 

  Click the button Trigger Scream to start the scream function. 

  Confirm the alarm by clicking OK. 

  Your device will emit a loud noise for 20 seconds. The scream cannot be 
terminated or paused during this time. 
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Lock 

On the Lock tab you have to enter a 4 digit PIN to lock and unlock your device. You may 
type in a customized message that will be displayed on the locked screen of your device. 
You can add a telephone number that can be called using the Call owner button on the 

locked device. 

 

Note 
It is strongly recommended to lock your device in order to trigger a wipe 
command. Please backup important data regularly. When there is a need to 

wipe the device, there is no opportunity to backup data at that moment. 

  Type in a 4 digit PIN into the Enter PIN field. 

  Confirm your PIN in the field below. 

  Click OK to trigger the lock. 

  You can unlock the device by entering the PIN on the device or by clicking the 
Unlock button on the Lock tab of your Web Console account. 

  You will only be able to unlock your device manually, if you have set a PIN 
beforehand. If you have forgotten the PIN you set, you will need to unlock your 
device via the Unlock button of your Web Console account. 

  Type in a customized message into the field Display message when lost  suitable 
to be displayed on your locked device, e.g. type a text and your email address to 
make it easy for the finder to get into contact with you. 

  Enter a telephone number that can be called using the Call owner button on the 
locked device into the field Alternate number to call if found. Use a trustworthy 
telephone number, such as your home phone number or a friend’s telephone 
number. 

  Click Lock in order to save the PIN to your device. 

  Click OK to lock the device. 

  Click Unlock if you want to unlock your device using the Web Console 

Blacklist 

If you don't want to be disturbed by certain calls or SMS, you may easily add telephone 
numbers to the Blacklist. The feature blocks unwanted calls and SMS. You may add 
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numbers from your list of contacts, the call log and the SMS log, or you enter a number 
manually. 

 

Adding a number from one of the device's logs to the Blacklist 

You may easily add a number to the blacklist from call log, SMS log or your list of 

contacts. 

  Open Avira Free Android Security on your device. 

  Tap Blacklist. 

  The Blacklist screen opens. 

  Tap the button Add. 

  The Add contact to blacklist screen opens. 

  Select from which log you want to add a telephone number to the blacklist and tap 
the appropriate button. 

 Tap Cancel if you don't want to add a number to the blacklist. 

 Touch the appropriate number you want to block. 

  The Enter contact details screen displays the phone number and the name of 
the contact you want to block. 

  Select a blocking option. You have the option to choose Calls & SMS, just Calls or 
only SMS. 

  Click Save to store the number to the blacklist. 

  The blocked number is displayed on the Blacklist screen. 

Note 
If the contact you want to add already exists in Blacklist, you will get an error 

message. 

Adding a number manually to the Blacklist 

You may add a number to the blacklist by typing it manually. 

  Open Avira Free Android Security on your device. 
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  Tap Blacklist. 

  The Blacklist screen opens. 

  Tap the button Add. 

  The Add contact to blacklist screen opens. 

  Tap Create contact manually, if you want to insert a telephone number. 

  The Enter contact details screen opens. 

  Touch the field Name to open the keypad for typing in the letters. 

  Touch the field Phone number to open the keypad for typing in the numbers. 

  Select a blocking option. You have the option to choose Calls & SMS, just Calls or 
only SMS. 

  Click Save to store the number to the blacklist. 

  The blocked number is displayed on the Blacklist screen. 

Editing a blocked contact 

You may edit the telephone number and the name of your blocked contact. 

  Open Avira Free Android Security on your device. 

  Tap Blacklist. 

  The Blacklist screen opens. 

  Tap the contact you want to edit. 

  The Edit blocked contact screen opens. 

  Touch the field Name to open the keypad for editing the name. 

  Touch the field Phone number to open the keypad for editing the telephone number. 

  Click Save to store the edited contact to the blacklist. 

  Click Cancel if you don't want to save the changes you have made. 

Blocked events 

You may check the history of all blocked contacts on the tab Blocked events. You can 
filter the list by certain options. The name of the contact, the date and time of the contact 

attempt as well as the way of contacting are displayed. 

  Tap the button All to select between All, Today or New events. 

  Tap the button Calls & SMS to see blocked calls and SMS attempts. Choose the 
option Calls to check who of your blocked contacts tried to call you. Or select SMS to 
call up the phone numbers of blocked short messages. 

Delete entries of the Blocked events 
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You may delete entries of the Blocked events. Filter the list of blocked events by All, 
Today or New and select between Calls & SMS, Calls or just SMS. You may delete 
single events as well as all events. For example, if you choose the filter All and Calls, all 
blocked calls are displayed on the list. You may now delete all blocked calls of your 
contacts at the same time. You have also the option to check single contacts and then 

delete the listed calls afterwards. 

 

  Tap the contact whose blocked events you want to delete. 

  The time and the number of incoming blocked calls and/or SMS are displayed. 

  Touch the SMS field to see the content of blocked SMS. 

  You can now open and read the short messages. 

  You can delete single or all SMS. 

 Tap Select all to mark the whole SMS history for removing process or, check single 
SMS. 

 Tap Delete to erase those short messages or tap Back to stop the deletion. 

  You are asked to confirm the deletion of blocked SMS. 

 Tap Delete to remove the selected SMS from history. 

 Tap Cancel to stop the removing process. 

  Touch the calls field to see all calls from your blocked contact. 

  You can now delete a single or all calling events. 
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 Tap Select all to mark the complete call history for removing process or check 
single calls. 

 Tap Delete to erase those calls or tap Back to stop the deletion. 

  You are asked to confirm the deletion of blocked calls. 

 Tap Delete to remove the selected calls from the history. 

 Tap Cancel to stop the removing process. 

Reports 

In the pane of the Settings tab you find the Report section that  displays all Avira Free 
Android Security activities performed using the Web Console. 

The logged information is listed by date and time. 

An example for the information displayed by the Activity report: 

Date Time Message 

Tuesday, August 
07, 2012 

3:17 
PM 

Device information 
refreshed successfully 

Tuesday, August 

07, 2012 

2:05 

PM 

Device located 

successfully 

Monday, August 
13, 2012 

6:11 
PM 

Device unlocked 
successfully 

 

Settings 

In the pane of the Settings tab you manage the name and the phone number of your 
device. Furthermore you can check the Report section here that displays all Avira Free 
Android Security activities performed using the Web Console. 
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  Click the device you want to manage in the side bar. 

  Type in a name for this device into the Device name field. 

  Enter the telephone number of this device into the Phone number field. 

  Click Save changes to save the settings you made for this device. 

  The Avira Android Web Console displays that the settings were saved 
successfully. 

Titel bar of the Webconsole 

Account Details 

The title bar of the Avira Web Console contains the link to your Account where you 

manage your account details. 

 

  Click the link. 

  The Account Details pane opens with the following fields: 

Date of creation 

Displays the date and the time when you registered the account. 

First name 

You may enter your first name here. 

Last name 

You may enter your family name here. 

Language 

Select your preferred language from the dropdown menu. 

Country 

Select your country of residence from the dropdown menu. 
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Account type 

Displays, which kind of account you are using, i.e. whether you have purchased the 
app or using a free version, etc. 

Save Changes 

  Please click Save Changes to save the account details you have changed. 

Password Management 

The title bar of the Avira Web Console contains the link to your Account where you 

manage your password. 

 

  Click the Account link. 

  The Password Management pane opens with the following fields: 

Password 

Please enter a new password for your Avira Free Android Security Account. 

Password confirmation 

Retype the password you have entered in order to confirm it. 

Change Password 

  Please click the button to save the changes you have made. 

Account Security 

The title bar of the Avira Web Console contains the link to your Account where you 
determine a security question. The Security question is designed to add extra security to 
your account. It can be used to identify yourself, in case you have lost or forgotten your 

login credentials or wish to change your email address. 

 

  Click the Account link. 
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  The Account Security pane opens with the following fields: 

Security question 

Opens the dropdown menu to select a security question that cannot be answered by 

anyone but yourself. Please select a question that suits you personally. 

Answer 

  Type you answer into the field Answer. 

  Please make sure, you use the correct spelling and a format that you find easy to 
remember. 

Save Changes 

  Please click Save Changes to save the answer for your Security question. 

Device Management 

The title bar of the Avira Web Console contains the link to your Account where you 
manage your device. 

 

  Click the Account link. 

  The Device Management pane opens with the following fields: 

Available devices 

Opens the dropdown menu to select one of your devices. 

Delete device 

  Please click the button to remove the selected device from your account. 

HowTo 

How do I change my email address? 

Should you need to change your email address, please contact the Avira Support. Your 
email address cannot only be used to contact you, it functions as your user identity at the 
same time. Therefore it cannot be changed by yourself via the Web Console or on the app 

on your device. 
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How do I keep data stored on my device secure? 

The easiest and simplest way to keep your data stored on your device secure, is to lock 

your device. 

  Log in to the Web Console. 

  Navigate to the Lock tab. 

  Enter a 4 digit PIN. 

  Confirm the PIN. 

  Click Lock. 

  The PIN can now be used to lock and unlock your device. 

Note 
The PIN is only temporarily valid. A new PIN is required for every lock/unlock 

command. 

How do I unlock my device if I have forgotten the PIN/entered an incorrect PIN three 
times? 

Note 
If you have entered an incorrect PIN on your device three times, you have to 
unlock the device via the Web Console first. Then you may send another lock 

command to your device. 

  Log in to the Web Console. 

  Navigate to the Lock tab. 

  Click the Unlock button. 

  Your device will be unlocked immediately. 

  Enter a new 4 digit PIN. 

  Confirm the PIN. 

  Click Lock. 

  Confirm the lock command by clicking OK. 

  The PIN can now be used to lock and unlock your device. 

How do I change my PIN? 

You can only change your PIN via the Web Console. It is not possible to change your PIN 

via the app itself. 

  Log in to the Web Console. 
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  Navigate to the Lock tab. 

  Enter a 4 digit PIN. 

  Confirm the PIN. 

  Click Lock. 

  The PIN can now be used to lock and unlock your device. 

How do I find my device when it is lost or stolen? 

If you have lost your device or if it was stolen, Avira Free Android Security offers two 
options in order to get back your device: 

Trigger a scream 

The Trigger Scream functionality is designed to facilitate you in finding your device. It 
is particularly useful when you have lost it in your vicinity, for example in your 

apartment. 

  Log in to the Web Console. 

  Select the tab Scream and click Trigger Scream. 

  Your device will now emit a loud noise for 20 seconds, to make it easier for you 
to find it. The scream will continue for a full 20 seconds and cannot be terminated 
or paused during this time. The scream will also be emitted if your device is 
muted. 

Note 
The scream will not be emitted if your device is switched off or out of battery 

power. 

Locate your device 

If you don’t know where you have lost your device or you have reason to believe that it 
was stolen, you may track the location of your device. 

Note 
The tracking process may take up to 3 minutes. You may not trigger the Locate 
Device command again while a device is being tracked. But you may trigger a 

Locate Device command for a different device registered to your account. 

  Log in to the Web Console. 

  Select the tab Locate Device. 

  An extract of Google Maps is displayed in the Avira Web Console. 

  Click Locate your device beneath the displayed map. 
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  The elapsed time is shown during the tracking process. The exact location of 
your device will be pinpointed on the map. The geophysical data will be shown 
as latitude and longitude. 

How do I register a new device to an existing account? 

You may add up to 5 devices to your account. All devices, added to the same Google 
account or email address via the app, are registered to the same Avira Free Android 
Security account, i.e. one email account has one Avira Free Android Security account with 

up to 5 different devices. 

  Use the device you want to add to your account to download Avira Free Android 
Security.  

  Install the app on your device. 

  Select either the Google Account or enter a different email address and tap Accept 
EULA and Continue. 

  You will receive a confirmation email at that address, confirming the registration 
of a new device to your existing Avira Free Android Security Account. 

  If you log in to the Web Console now, the new device will have been added to 
the section All your devices on the left hand side of the Web Console. 

  You may now click Edit on the device tab to enter the settings in order to change the 
name of the device as well as the phone number. 

Note 
Because there can only be added 5 devices to one Avira Free Android Security 
Account, you may only add a new device if you delete one device from your 
account and then delete the app from one of the registered devices. First, go to 
the Account settings in the Web Console of your Avira Free Android Security 
account and select one device from the dropdown list under Device 
Management and click Delete device. Then delete the application from the 

selected device. 

Troubleshooting 

Troubleshooting 

Messages 
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Message Meaning 

Please connect to a mobile or Wi-Fi 
network to continue. 

No network connections were found 
during registration process. Please 

enable network connectivity to continue. 

The service is currently unavailable. 
Please try again later. 

The Google service is currently not 
available. 

Avira Free Android Security has 
crashed. Please tap here to help us 

fix the issue. 

An unexpected error occurred, forcing 
the application to stop. By tapping on the 
notification and confirming with OK, the 

error log will be sent to us automatically. 

You need a Google Account to 
register your device. Please create 
one and try again. 

No Google account was found on the 

device. 

Your Google Account password has 
changed. Please open Gmail or 
Google Play app to update the 

password on the device. 

The default Google account on this 
device has an invalid password. Please 
check if you have changed the 
authentification for your Google account. 
Please update and synchronize your on-
device password, either by launching the 

Gmail or Google Play app. 

Too many applications on your 
device are using the Google push 
service (C2DM). Please uninstall 

one and try again. 

Google sets a limit for C2DM-enabled 

applications installed on a device. 

An error has occurred. Please try 
again later. 

An unknown error has occurred. 

There are more than five devices 
registered with this account. Please 

delete one to add another. 

The maximum of five devices registered 
to Avira Free Android Security has been 

reached. 
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This device is no longer registered 
with an Avira Free Android Security 
Account. The app has therefore 

been reset. 

Your registration has been reset 
because this device was deleted from 

the list of registered devices. 

A server error has occurred. Please 
try again later. 

An unknown server error has occurred. 

An unexpected error has occurred 
forcing the application to stop. 
Please help us to fix this issue. Just 
click OK and the error log will be 

sent to us automatically. You may 
also add some comments on this 

issue below: 

An unexpected error has terminated the 

application. 

Unexpected error. Please consult 
notification bar. 

An unexpected error has occurred. 

Thank you! Thank you for reporting the problem, the 
information was sent successfully. 

In case of loss or theft of your 
device Avira Free Android Security 
can help you to perform a factory 
reset to wipe data from the device. 
In order to perform a factory reset, 
device administrator must be 

activated. 

If your device is lost,  Avira Free Android 
Security can help you wipe data from the 
device with a factory reset. To do so, the 
Device Administrator function must be 
activated. 

Wipe via factory reset 
enabled/disabled. 

The Wipe function with Factory Reset 
command is enabled/disabled. 

Your device was sucessfully 
registered with Avira Free Android 

Security! 

Avira Free Android Security was 

registered successfully! 
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An email has been sent to 
<john.doe@gmail.com>. Please 
check your email account for 

information and further instructions. 

An email with activation information has 
been sent to <john.doe@gmail.com>. 
Please check it to start your experience 

with us! 

If you have any questions, please 
visit Support Forum or contact us 

here at Avira. 

If you have any questions, please visit 
our Forum or contact us. 

Registration failed. Please restart 
the app and try again. 

An unexpected error has occurred 
during registration process. Please 
restart the application and try again to 

register. 

Registration failed. You might be 
using technology incompatible with 
Avira Free Android Security. Please 
restart the app and try again. 

Your device might be using a technology 
that is not compatible with Avira Free 
Android Security. Please refer to the 
system requirements that are the 
following: 
Operating system: Android 2.2 (Froyo) - 
Android 2.3.7 (Gingerbread). 
Memory: 1.28 MB free memory space. 
Browsers: Mozilla Firefox, Google 
Chrome, Opera and Internet Explorer 

IE7 or higher. 

Contact creation failed The contact could not be added to the 

blacklist because it is already on the list. 

Name already exists in blacklist This name is already on the blacklist, 
therefore you can't add it a second time. 

Contact already exists in blacklist This contact is already on the blacklist, 

therefore you can't add it a second time. 

Number already exists in blacklist 
for <John Doe> 

This telephone number is already on the 
blacklist and can be found under <John 
Doe>, therefore you can't add it a 
second time. 
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Glossary 

Abbreviation Meaning 

C2DM Google’s Android Cloud-to-Device-
Messaging is a service that helps to send 
data from servers to the application on your 

device. 

IMEI International Mobile Equipment Identity is a 
unique number, similar to a unique 
fingerprint, to identify your device. 

SIM card Subscriber Identification Module card is a 
provider’s card on which different 
information is stored, such as the serial 

number, the telephone number or your PIN. 

PIN Personal Identification Number, usually a 4 

digit number. 

OS The Operating System of your device. 

GPS Global Positioning System is a satellite-
based system that provides location and 

time data to GPS receivers. 

Cell Tower technology Advanced radio technology that picks up 
mobile phone signals and passes them to 

other towers, using radio waves. 

WiFi It is a standard that enables the exchange 
of data and the wireless access to the 

Internet via a network access point. 

W-LAN Wireless Network Access. 

Cloud It is a remote server location and 
computing infrastructure. Data stored on 
the cloud are not stored locally on your 

computer. 
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Alternative telephone 
number 

The telephone number that can be called 
from your locked device, using the button 

Call owner. 

Latitude Geographic coordinate that specifies the 
north-south position on the Earth. 

Longitude Geographic coordinate that specifies the 
west-east position on the Earth. 

Service 

Support 

Support service 

All necessary information on our comprehensive support service can be obtained from our 
website http://www.avira.com. 

Community Forum 

Before you contact the hotline, we recommend that you visit our user forum at 
http://forum.avira.com. 

FAQs 

Please also read the FAQs section on our website: http://www.avira.com/en/support-for-
home-knowledgebase. 

Your question may already have been asked and answered by other users in this section. 

Contact 

Address 

Avira Operations GmbH & Co. KG 
Kaplaneiweg 1 
D-88069 Tettnang 

Germany 

Internet 

You can find further information about us and our products at the following address: 

http://www.avira.com 

http://www.avira.com/
http://forum.avira.com/
http://www.avira.com/en/support-for-home-faq
http://www.avira.com/en/support-for-home-faq
http://www.avira.com/
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10.7 General 

The Avira product can send messages via email. This is done with the Simple Message 
Transfer Protocol (SMTP). 

The messages can be triggered by various events. The following components support 
email sending: 

Note 
Please note that ESMTP is not supported. In addition, an encrypted transfer via 
TLS (Transport Layer Security) or SSL (Secure Sockets Layer) is currently not 
possible. 

Email messages 

SMTP Server 

Enter the name of the host to be used here - either its IP address or the direct host 
name. 

The maximum possible length of the host name is 127 characters. 

For example: 

192.168.1.100 or mail.samplecompany.com. 

Port 

Enter the port to be used here. 

Sender address 

In this input box, enter the email address of the sender. The maximum length of the 
sender's address is 127 characters. 

Authentication 

Some mail servers expect a program to verify itself to the server (log in) before an email is 
sent. Alerts can be transmitted with authentication to an SMTP server via email. 

Use authentication 

If this option is enabled, a user name and a password can be entered in the relevant 

boxes for login (authentication). 

Login name: 
Enter your user name here. 

Password: 
Enter the relevant password here. The password is saved in encrypted form. For 
security reasons, the actual characters you type in this space are replaced by 
asterisks (*). 
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Send test email 

When you click on the button, the program attempts to send a test email to the sender 
address to check the data entered. 

10.7.1 Threat categories 

Selection of extended threat categories (Options available in expert mode only) 

Your Avira product protects you against computer viruses. In addition, you can scan 
according to the following extended threat categories. 

 Adware 

 Adware/Spyware 

 Applications 

 Backdoor Clients 

 Dialer 

 Double Extension Files 

 Fraudulent software 

 Games 

 Jokes 

 Phishing 

 Programs that violate the private domain 

 Unusual runtime packers 

By clicking on the relevant box, the selected type is enabled (check mark set) or disabled 
(no check mark). 

Select all 

If this option is enabled, all types are enabled. 

Default values 

This button restores the predefined default values. 

Note 
If a type is disabled, files recognized as being of the relevant program type are 
no longer indicated. No entry is made in the report file. 
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10.7.2 Password 

You can protect your Avira product in different areas with a password. If a password has 
been issued, you will be asked for this password every time you want to open the 
protected area. 

Password 

Enter password 

Enter your required password here. For security reasons, the actual characters you 
type in this space are replaced by asterisks (*). The password can only have a 
maximum of 20 chars. Once the password has been issued, the program refuses 

access if an incorrect password is entered. An empty box means "No password". 

Confirmation 

Confirm the password entered above by entering again here. For security reasons, the 

actual characters you type in this space are replaced by asterisks (*). 

Note 

The password is case-sensitive! 

Areas protected by password (Options available in expert mode only) 

Your Avira product can protect individual areas with a password. By clicking the relevant 
box, the password request can be disabled or re-enabled for individual areas as required. 

Password-protected 

area 

Function 

Control Center If this option is enabled, the pre-defined 
password is required to start the Control 

Center. 

Activate / 
deactivate Real-
Time Protection 

If this option is enabled, the pre-defined 
password is required to enable or disable 
AntiVir Real-Time Protection. 
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Activate / 
deactivate Web 

Protection 

If this option is enabled, the pre-defined 
password is required to enable/disable Web 

Protection. 

Quarantine If this option is enabled, all areas of the 
quarantine manager protected by a password 
are enabled. By clicking on the relevant box, 
the password enquiry can be disabled or 
enabled again on request for individual areas. 

Restore 
affected 

objects 

If this option is enabled, the pre-defined 
password is required to restore an object. 

Rescan 
affected 

objects 

If this option is enabled, the pre-defined 
password is required to rescan an object. 

Affected 
object 

properties 

If this option is enabled, the pre-defined 
password is required to display the properties 

of an object. 

Delete 
affected 

objects 

If this option is enabled, the pre-defined 
password is required to delete an object. 

Send email to 

Avira 

If this option is enabled, the pre-defined 
password is required to send an object to the 
Avira Malware Research Center for 

examination. 

Configuration If this option is enabled, configuration of the 
program is only possible after entering the pre-

defined password. 

Installation / 

uninstallation 

If this option is enabled, the pre-defined 
password is required for installation or 
uninstallation of the program. 

10.7.3 Security 

Options available in expert mode only. 
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Autorun 

Block autorun function 

If this option is enabled, the execution of the Windows autorun function is blocked on 
all connected drives, including USB sticks, CD and DVD drives and network drives. 
With the Windows autorun function, files on data media or network drives are read 
immediately on loading or connection, and files can therefore be started and copied 
automatically. This functionality carries with it a high security risk, however, as 
malware and unwanted programs can be installed with the automatic start. The 
autorun function is especially critical for USB sticks as data on a stick can be changed 

at any time. 

Exclude CDs and DVDs 

When this option is enabled, the autorun function is permitted on CD and DVD drives. 

Warning 
Only disable the autorun function for CD and DVD drives if you are sure you are 
only using trusted data media. 

System protection 

Protect Windows hosts files from changes 

If this option is set to activated, the Windows hosts files are write-protected. 
Manipulation is no longer possible. For example, malware is not able to redirect you to 

undesired websites. This option is activated as the default setting. 

Product protection 

Note 
The product protection options are not available if the Real-Time Protection has 
not been installed using the user-defined installation option. 

Protect processes from unwanted termination 

If this option is enabled, all processes of the program are protected against unwanted 
termination by viruses and malware or against 'uncontrolled' termination by a user, e.g. 
via Task-Manager. This option is enabled as the default setting. 

Advanced process protection 

If this option is enabled, all processes of the program are protected with advanced 
options against unwanted termination. Advanced process protection requires 
considerably more computer resources than simple process protection. The option is 
enabled as the default setting. To disable this option, you have to restart your 
computer. 
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Note 

Password protection is not available for Windows XP 64 bit ! 

Warning 
If process protection is enabled, interaction problems can occur with other 

software products. Disable process protection in these cases. 

Protect files and registry entries from manipulation 

If this option is enabled, all registry entries of the program and all program files (binary 
and configuration files) are protected from manipulation. Protection against 

manipulation entails preventing write, delete and, in some cases, read access to the 
registry entries or program files by users or external programs. To enable this option, 

you have to restart your computer. 

Warning 
Please note that, if this option is disabled, the repair of computers infected with 
specific types of malware may fail. 

Note 
When this option is activated, changes can only be made to the configuration, 

including changes to scan or update requests, by means of the user interface. 

  

Note 
Protection for files and registration entries is not available for Windows XP 64 

bit ! 

10.7.4 WMI 

Options available in expert mode only. 

Support for Windows Management Instrumentation 

Windows Management Instrumentation is a basic Windows management technology that 
uses script and programming languages to allow read and write access, both local and 
remote, to settings on Windows systems. Your Avira product supports WMI and provides 
data (status information, statistical data, reports, planned requests, etc.) as well as events 
via an interface. WMI gives you the option of downloading operating data from the 

program 
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Enable WMI support 

When this option is enabled, you can download operating data from the program via 
WMI. 

10.7.5 Events 

Options available in expert mode only. 

Limit size of event database 

Limit size to max. n entries 

If this option is enabled, the maximum number of events listed in the event database 
can be limited to a certain size; possible values: 100 to 10000 entries. If the number of 

entered entries is exceeded, the oldest entries are deleted. 

Delete all events older than n day(s) 

If this option is enabled, events listed in the event database are deleted after a certain 
period of time; possible values: 1 to 90 days. This option is enabled as the default 

setting, with a value of 30 days. 

No limit 

When this option has been activated, the size of the event database is not limited. 
However, a maximum of 20,000 entries are displayed in the program interface under 
Events. 

10.7.6 Reports 

Options available in expert mode only. 

Limit reports 

Limit number to max. n piece 

When this option is enabled, the maximum number of reports can be limited to a 
specific amount. Values between 1 and 300 are permissible. If the specified number is 

exceeded, then the oldest report at that time is deleted. 

Delete all reports older than n day(s) 

If this option is enabled, reports are automatically deleted after a specific number of 
days. Permissible values are: 1 to 90 days. This option is enabled as the default 

setting, with a value of 30 days. 

No limit 

If this option is enabled, the number of reports is not restricted. 
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10.7.7 Directories 

Options available in expert mode only. 

Temporary path 

Use default system settings 

If this option is enabled, the settings of the system are used for handling temporary 
files. 

Note 
You can see where your system saves temporary files - for example with 

Windows XP - under: Start > Settings > Control Panel > System > Index 
card "Advanced" Button "Environment Variables". The temporary variables 

(TEMP, TMP) for the currently registered user and for system variables (TEMP, 

TMP) are shown here with their relevant values. 

Use following directory 

If this option is enabled, the path displayed in the input box is used. 

Input box 

In this input box, enter the path where the program will store its temporary files. 

 

The button opens a window in which you can select the required temporary path. 

Default 

The button restores the pre-defined directory for the temporary path. 

10.7.8 Acoustic alerts 

Options available in expert mode only. 

When a virus or malware is detected by the System Scanner or Real-Time Protection, an 
acoustic alert is heard in interactive action mode. You can now choose to activate or 
deactivate the acoustic alert and select an alternative WAVE file for the alert. 

Note 
The action mode of the System Scanner is set in the configuration under 

System Scanner > Scan > Action on detection. 
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No warning 

When this option is enabled, there is no acoustic alert when a virus is detected by the 
System Scanner or Real-Time Protection. 

Use PC speakers (only in interactive mode) 

If this option is enabled, there is an acoustic alert with the default signal when a virus 
is detected by the System Scanner or Real-Time Protection. The acoustic alert is 

sounded on the PC's internal speaker. 

Use the following WAVE file (only in interactive mode) 

If this option is enabled, there is an acoustic alert with the selected WAVE file when a 
virus is detected by the System Scanner or Real-Time Protection. The selected WAVE 

file is played over a connected external speaker. 

WAVE file 

In this input box you can enter the name and the associated path of an audio file of 
your choice. The program's default acoustic signal is entered as standard. 

 

The button opens a window in which you can select the required file with the aid of the 

file explorer. 

Test 

This button is used to test the selected WAVE file. 

10.7.9 Alerts 

Your Avira product generates so-called slide-ups, desktop notifications for specific events, 
which give information on successful or failed program sequences such as updates. Under 
Alerts you can enable or disable the notifications for specific events. 

With desktop notifications, you have the option of disabling the notification directly in the 
slide-up. You can reactivate the notification, in the Alerts configuration window. 

Update 

Alert, if last update is older than n day(s) 

In this box, you can enter the maximum number of days allowed to have passed since 
the last update. If this number of days has passed, a red icon is displayed for the 
update status under Status in the Control Center. 

Show notice if the virus definition file is out of date 

If this option is enabled, you will obtain an alert if the virus definition file is not up-to-
date. With the help of the alert option, you can configure the temporal interval for an 

alert if the last update is older than n day(s). 
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Warnings / Notes with the following situations 

Dial-up connection is used 

If this option is enabled, you will receive a desktop notification alert if a dialer creates a 
dial-up connection on your computer via the telephone or ISDN network. There is a 
danger that the connection may have been created by an  unknown and unwanted 
dialer and that the connection may be chargeable. (see Viruses and more > Threat 

categories: Dialer) 

Files have been successfully updated 

If this option is enabled, you will receive a desktop notification whenever an update 

has been successfully performed and files updated. 

Update failed 

If this option is enabled, you will receive a desktop notification whenever an update 
fails: No connection to the download server could be created or the update files could 
not be installed. 

No update necessary 

If this option is enabled, you will receive a desktop notification whenever an update is 
started but installation of the files is not necessary as your program is up to date. 
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